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Thank You for Choosing Ross  
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology.  

Our mission is to:  

1. Provide a Superior Customer Experience 

• offer the best product quality and support 

2. Make Cool Practical Technology 

• develop great products that customers love 
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below. If anything at all with your Ross 
experience does not live up to your expectations, be sure to reach out to us at 
solutions@rossvideo.com.  

 

David Ross 
CEO, Ross Video 
dross@rossvideo.com  

Ross Video Code of Ethics 
Any company is the sum total of the people that make things happen. At Ross, our employees 
are a special group. Our employees truly care about doing a great job and delivering a high-
quality customer experience every day. This code of ethics hangs on the wall of all Ross Video 
locations to guide our behavior: 

1. We will always act in our customers’ best interest.  
2. We will do our best to understand our customers’ requirements. 
3. We will not ship crap. 
4. We will be great to work with.  
5. We will do something extra for our customers, as an apology, when something 

big goes wrong and it's our fault. 
6. We will keep our promises. 
7. We will treat the competition with respect. 
8. We will cooperate with and help other friendly companies. 
9. We will go above and beyond in times of crisis. If there's no one to authorize 

the required action in times of company or customer crisis - do what you know 
in your heart is right. (You may rent helicopters if necessary.)  
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Welcome 
Graphite is a powerful solution with multiple components offering you the tools to: 

• Mix and Play Composite video (Ross Carbonite production switcher) 

• Create, Animate and Play Graphics (Ross XPression graphics system) 

• Mix and Control Audio (RAVE) 

• Access and Utilize Clips (Ross XPression Clips) 

• Control everything from an easy-to-use virtual interface (Ross DashBoard) 
You may already know how to use some of these tools. You can learn about these tools in-
depth with Ross Video’s extensive learning resources including Ross University online, user’s 
guides, additional product training manuals or customized on-site training. For more information 
about these resources, please visit rossvideo.com. 

This document is designed to get you on your way quickly and easily with simple instructions for 
some of the most commonly required tasks for Graphite users. 

Before you begin, all component systems and their inputs and outputs must be set up and 
configured. More information is available in the product manuals and in additional training 
materials. 

For a quick introduction to Graphite, see the Graphite video gallery: 

https://www.rossvideo.com/production-switchers/graphite/video-gallery/ 
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Section 1: Three easy lessons familiarize you with accessing various types of content. 

• Lesson 1 offers basic information about preparing existing XPression 
graphics for playout. For detailed information about creating, modifying or playing 
XPression graphics, refer to the XPression training manual or product 
documentation or to the many useful videos online at rossvideo.com. 

• Lesson 2 offers a basic tour of accessing clips via XPression Clips and the 
DashBoard Media Manager. 

• Lesson 3 offers a basic tour of RAVE, Graphite’s audio mixing toolset. 
Section 2: Tutorials offer examples and basic information about creating Custom Controls and 
Memories to streamline common tasks. With each tutorial, assign a series of actions to a single 
button that you can press either in DashBoard, on your Control Panel or on an auxiliary shot 
box. 

• Tutorial 1: Custom Controls and Memories 

• Tutorial 2: Control Commands for XPression Graphics 

• Tutorial 3: Take Graphics and Cut Key 

• Tutorial 4: Double-Boxes with XPression Graphics 

• Tutorial 5: Animated Wipes with XPression Graphics 

• Tutorial 6: Animated Wipes with a Media Wipe Transition 

• Tutorial 7: Chroma Key for “Green Screen” Video 

• Tutorial 8: Custom Controls for Audio 

• Tutorial 9: Set Up a Show Open Sequence 
 

  



 

 

 

Section 1: 
Access Content 

In this section: 

• Lesson 1: Load XPression Graphics 

• Lesson 2: Tour Tools for Using Clips 

• Lesson 3: Tour the RAVE Audio Mixing Tools 
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Lesson 1      Access XPression 
Graphics  

Understanding XPression Fundamentals 
XPression graphics exist in project files, saved with the .xpf extension.  Each project 
contains one or more scenes. Each scene contains one or more objects, such as text, 
images, video or other design elements.  

To play scenes, the project must be open and the scenes loaded to a sequence even if you do 
not plan to play them in sequential order. You can play one scene at a time as with a traditional 
page-based character generator. Or, by assigning scenes to different frame buffer layers, you 
can play more than one scene at a time, allowing one or more scenes to persist on-air while you 
play other scenes on or off, all within a single channel. 

For the following tutorial, you need to have an XPression project already saved on your system. 
You can use your own project, a purchased graphics package or the demo project that comes 
with the system.  

If you are using a graphics package designed on a different model of XPression, note that with a 
standard Graphite system: 

• You have one XPression graphics channel 

• You do not have Transition Logic or 3D objects (available on some other 
XPression models). 

Therefore, if you are using a project created on another XPression system, you may need to 
make the appropriate modifications. 

Typically, each graphic scene functions as a template, with text, images, scores or other data 
replaced as needed to support the broadcast. However, it is important to note that only those 
objects in the scene that have been designated as Published may be replaced within 
XPression’s playout interface or via an external source. For more about creating templates, 
refer to the XPression training manual, product documentation or Ross University online videos 
at rossvideo.com. 

Let’s explore working with XPression graphics.  
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In this tutorial: 

> Open XPression 
> Load an XPression Project 
> Access the Sequence interface 
> Add graphics to a sequence 
> Modify a graphic’s content 

 

Lesson 1      Load a Graphics Package 

1. Double-click the XPression Graphite desktop icon to open the XPression interface.    

 

2. The application may open to the interface for graphics creation (Layout) or playout 
(Sequence). Look at the very top of the interface, near the middle. Locate the Layout 
and Sequence tabs.  Click the Sequence tab.  

 

3. The interface to play a sequence of graphics appears. You can also toggle from 
Sequence to Layout, or vice versa with keyboard shortcuts. Press F3 on your keyboard 
to return to the Layout interface. Press F4 to return to the Sequence Layout.  

  



 

13 
 

4. Like most programs that run on a Windows ™ operating system, XPression opens and 
saves files from the File menu. Click File from the Main Menu, and then click Open 
Project.   

 

5. The Open Project window appears. Navigate to the project that you want to open. If you 
plan to use a sample training project, go to:  

D:\Projects\ 

In the Demo folder, double-click to open the folder:  

ROSS NEWS EVENING – GRAPHITE 

 On some systems, you may find this in a sub-folder or different location. 

6. In this folder, you can see several sub-folders with all the assets for this project. You can 
also see the .xpf file for this project. Select this project file and click Open. 

 
7. You may see a Confirm dialog that asks if you want to save changes to the existing 

untitled project. Click No unless you have a working project open that you need to save. 
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8. As the project opens, all the template scenes available in this project appear in the 
Scene Manager, at the left of the interface. You can use any of them one or more times, 
changing the text or images as needed. 
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9. This project already has scenes in the sequence, ready for playout. In this sequence, 
notice that the scenes are organized into groups by scene type. 

 

10. To add a scene to the sequence so that it can be played, click and drag the scene from 
the Scene Manager to the Sequence List. Choose a scene that has text and add it to the 
Sequence List. 

   

A new iteration of this scene appears in the Sequence List. 
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11. The scene that you just added to the list should still be highlighted in the list. If it is not, 
click anywhere in the row for that scene to highlight it. 
 

12. In the Take Inspector, near the bottom left of your screen, select the Template Data tab 
if it is not already selected. 

 

13. In the Objects List in the Take Inspector, click to select the Text object that you want to 
modify. Typically, this object has placeholder text that indicates the purpose of this field. 
You are going to change this to display the actual text that you want on air. In the 
example here, the placeholder text is UPPER FLAG. 

 

14. In the field to the right of the Objects List, click the Static tab that is at the bottom. This 
tab allows you to manually enter text for this object. 
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15. Click to place your cursor in the large white area on the Static tab and type the text that 
you want to enter in your graphic. If there is existing text that you do not want, you can 
delete it here. In the example here, the placeholder text, UPPER FLAG is replaced with 
BREAKING REPORT. Notice that you can preview the text in the graphic at the right of 
this area. 

 

 Only objects designated as Published in the graphic creation process may be 
modified. For more information about template creation and publishing objects, refer to 
the XPression training manual. 

16. Observe that there are two additional tabs below the field where you typed the 
replacement text. 

• Widgets allow you to access pre-configured text lists, clocks or timers. These items 
are available only if they have been built into the template.  

• DataLinq allows you to populate the text object with an external source if the 
template has been configured for a DataLinq connection. 

 For more about Widgets and DataLinq, refer to online resources or to the 
XPression training manual. 
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17. Look at the Sequence Playlist on the right side of the interface. Make sure that the 
Thumbnail tab is selected. This area looks a lot like the Scene Manager on the left, with 
thumbnails of your scenes. However, these thumbnails show each iteration of each 
scene in the playlist with any modifications made to the original template. Notice that the 
text that you just entered appears in only one iteration of that scene.  

 

18. You can manually navigate and play items in the playlist. Press the Numlock key on your 
keyboard. Click the Fast Recall above the Playlist so that it is green and enabled. 
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19. Experiment with these keyboard shortcuts: 

 
To select an item in the playlist 

Press the Up arrow key 
or the Down arrow key 

To cue an item in the playlist with its ID  Enter the Take ID (from the first column in 
the playlist) on the Numeric keypad 

To play the currently selected item Press Enter on the Numeric keypad 

To take the currently cued item online 
and cue the next item in the list 

Press + on the Numeric keypad 

To take the currently playing item 
offline and cue the next item in the list 

Press – on the Numeric keypad 
 

To clear all channels Press Escape two times 

To insert another item in the playlist Press Ctrl + I to open the Insert window 

Custom Controls for Graphics 
You can play graphics manually, as demonstrated in this exercise, or you can create Custom 
Controls to trigger graphics. A Custom Control allows you to trigger one or more actions with a 
single click in the Ross DashBoard ShotBox interface, the Carbonite Control Panel or with an 
optional shot box. 

For more about creating Custom Controls for graphics, see Custom Controls Lesson 1, later in 
this book.  
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Lesson 2      Explore Clips, 
Animations and Stills 

Graphite Media Workflows 
With Graphite, there are several ways that you can use media in your broadcast. 

• Within XPression Graphite, you can use an image or a clip as a material on an 
object in a graphic. This can be for design purposes, such as an abstract moving 
design for the background of a lower third. Or, there may be an image or video of 
an event, perhaps displayed on an over-the-shoulder or double-box object to 
support a story. Using images or clips as materials is part of the XPression graphic 
design process and is not covered in this manual. For more details, refer to the 
XPression Training: Design Basics or to Ross University XPression U tutorial 
videos, available at Rossvideo.com 

• Within XPression Graphite, you can open the XPression Clip Browser and either 
play graphics directly from the Clip Browser or drag them into the Sequence List. 
You can play any clip encoded with the XPression AVI codec, including: 

> Any clip recorded with XPression Graphite’s Record Client 
> Any clip encoded with the XPression Video Coder 
> Any clip encoded with the XPression INcoder 

 XPression INcoder is a separate product, available for purchase. XPression 
INcoder offers workflow efficiencies including intelligent watch folders, multi-target 
publishing, and embedded meta-data. 

• You can also access media stored on a USB inserted into USB port on the 
Graphite frame.  The media is accessible via DashBoard’s Media Manager or via 
the Control Panel. This workflow works well for still images, audio and short 
animations. Due to storage capacity, it is not meant for longer clips. Graphite 
includes 8 GB of internal storage. Supported file types include: 

.bmp 

.jpg 

.tga (with or without alpha) 

.png (with or without alpha) 

.wav 

To prepare to access images, animations or clips for other lessons in this book, let’s explore the 
available tools. 
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In the following tutorial: 

> Record, play and edit clips 
> Open and explore the XPression Clip Browser 
> Open and explore the Clip Server window 
> Open and explore the Crash Record window 
> Open and explore XPression Video Coder 
> Open and explore the DashBoard Media Manager 

 

Lesson 2      Explore Clips, Stills and Animations 

Part 1 – Getting Started 

1. If it is not already running, open XPression Graphite from the desktop icon. 

 

2. XPression defaults to the Sequence Layout, or you can press F4. 
 

3. XPression uses a specified Clip Store. This may already be configured. However, should 
you need to access these settings, click Edit>Clip Store Setup. Then in the Clip Store 
Setup window, enter the Host Name and Port number and then click OK. 
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Part 2 – The Clip Browser 

1. Click Display>Clip Browser. 

 

2. The Clip Browser appears. Click and drag the edges to size it to fit below the playlist. 
Click and drag the title bar of this window to position it. 
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3. Drag a file from the Clip Browser to the Sequence List. Once a clip is in the sequence 
list, you can play it to its designated server channel just as you would play any graphic in 
the list to its designated framebuffer. 

4. In the Clip Browser, click the Fast Recall button. This enables recall of numerically 
named files in the Clip Browser from your PC keyboard’s numeric keypad. 

 

5. On the numeric keypad of your keyboard, enter the number of a numerically named 
video file. The Clip Browser populates with only this file. 
 

6. In the Quick Find field, enter the complete or partial file name for one of the videos in the 
browser. The Clip Browser populates with only this file. 
 

7. Click the Show/Hide button to access other search criteria. When you are finished 
exploring here, click the Show/Hide button again to close these controls. 

 

8. To remove all filters and repopulate the clips list, click Reset Filter. 
 

9. Right-click an item in the Clip Browser and from the popup menu, choose Edit. 
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The Clip Edit window appears. 

 

10. You can edit your clip and create a new sub-clip: 

• Set an In Point and an Out Point to trim your clip. 

• Click the looping tab and set up looping from start to finish or from two specified 
points in the clip. Designate the number of times the clip is to loop or set infinite 
looping. 

• Play and test the edited sub-clip. 

• Save the edited sub-clip. 

When you finish experimenting, close the Clip Edit window. 
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Part 3 – The Server Channel Window 

XPression Graphite typically includes a single graphics channel and two clip server channels. 
You can display a window to monitor the clip server channels and play clips directly from this 
window. 

1. Click Display>Server Channels. 

 

The Server Channels window opens. If you do not see it, you may need to resize and 
reposition some of your windows. 
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2. Click the Options tab. Here you can adjust the appearance and behavior of the Server 
Channels window. 

 

3. Drag a clip from the Clip Browser to the Preview thumbnail for either Server Channel 
and then click the Take button. The clip plays to the server channel. 
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4. Drag a clip from the Clip Browser directly to either Server Channel thumbnail in the 
Server Channel window and click the Play button. 

 

5. Click the Enable Loop button and click the Play button again. Each time the clip plays to 
the end, it automatically repeats from the beginning. 
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6. In the Server Channels window, click the Transitions tab, near the top. 

 

7. Click the In tab, near the bottom. Use the controls on this tab to specify how a clip 
transitions on. 
 

8. Make a selection from the Transition column and then the Mode column. If the transition 
is a cut, then no Mode selection is needed. 

 
9. In the Duration field, type a value to indicate the number of frames for the transition. 

 
10. Check the Reverse checkbox to reverse the transition effect, or leave it unchecked. 
 
11. Click the Out tab, near the bottom, and then enter the transition and duration settings to 

specify how the video is to transition out.  

Part 4 – The Crash Record Window 

This tool allows you to record video with embedded audio from any of your input sources. 

1. In XPression, click Tools>Record Client. 
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The Record Client Window appears. 

 

2. From the Input dropdown at the top, select the video input that you want to record. 
 

3. In the Base Name field, enter a file name for your new recording. 
 

4. From the Bit Depth dropdown, choose 24 Bit RGB or 32 Bit RGBA depending on 
whether you want to capture an alpha channel (RGBA) or not. 

 
5. From the Audio Channels dropdown, specify the number of Audio Channels that you 

want to capture: 2,4, 6, 8, 10, 12, 14, or 16. 
 

6. Click the Grab Settings button and specify the Interlaced setting for the input video and 
the file format that you want to generate (TGA or PNG). 

 
7. Use the Browse button (…), the Explore button or the Folder tree to specify a location for 

your new recording.  

 To specify a default location for your recordings, click 
Edit>Preferences>Folders>Default Grab and Record. 
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8. Click Crash Record. 

 

9. Notice that the Crash Record button is now a Stop Record button. Click this button when 
you want to stop recording. 
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10. To put the recorded file in the Clip Store so that you can access it in the Clip Browser, 
right-click the file. From the popup menu, choose Send to Clip Store. 

 

11. Make settings in the Send to Clip Store window and then click Send to Clip Store. The 
clip appears in the Clip Browser. 

Part 5 – The XPression Video Coder 

The XPression Video Coder allows you to encode clips to play with XPression.  

1. Click the XPression Video Coder icon on your desktop. 
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The XPression Video Coder window appears.  

 

2. Click the New Job button. 
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The Open Video Source File window appears. 

 

3. Navigate to a video file that you want to encode for use with XPression Graphite, select 
it and then click Open. 
 

4. You want to tell the system about the video source that you just selected. Make the 
appropriate settings in the Source Properties area, including the Video Source, Alpha 
Source and Audio Source tabs. 

 

5. Next, you want to specify the properties of the encoded video. Make the appropriate 
settings in the Target Properties area. 
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6. With this job selected in the Job List, click To Render Cue.  

 

7. Click Render. 

 

8. Once the Progress Bar indicates that the job is 100% rendered, click the Clear Finished 
button, or right-click the item and from the popup menu, choose Clear Finished. 

 

9. If you want this new clip to appear in your XPression Clip Browser, return to the 
XPression Record Client window (Tools>Record Client). 
 

10. Navigate to the folder where you rendered the new clip. 
 
11. Right-click the clip and choose Send to Clip Store. 
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Part 6 – Use Media with DashBoard’s Media Manager 

With the Media Manager, you can access media stored on a USB drive or internally on the 
Graphite. A typical and convenient workflow is to keep all media needed for a certain show on a 
USB drive and insert that drive as you prepare for the show. The Media Manager is useful for 
still images and shorter animations, but is not meant for longer clips. 

 Internal storage to the Media Manager does not occur on the Windows platform 
and is an advanced procedure. For further instructions about internal storage refer to 
Graphite user documentation. 

1. From the Windows desktop, double-click the DashBoard icon to open DashBoard. 

 

2. In the Basic Tree View, navigate to the Graphite system and expand this item in the tree. 

 

 If Graphite does not appear in the Basic Tree View: 

1. Locate its IP address. When you power on the Control Panel, the IP address appears in 
the mnemonic display in the Menu area near the top of the panel. 

2. In DashBoard in the Basic Tree View, click the (+)Add New Connection button. The New 
window appears. In this window, expand the General category and then click to select 
Manual Connection. Click Next. The Manually Detect Device window appears. Enter the 
Graphite Panel IP address so that DashBoard can locate it on the network and then click 
Finish.  
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3. Do one of these to open the Media Manager: 

• Double-click Media Manager if you have not previously opened it in this session, or 
simply click if you have already opened it. 

• Click the Navigation Menu button at the bottom right, and then click Media 
Manager. 

 

4. Expand the USB carat or the Internal carat in the Browse area and navigate to stored 
media files. 

 

5. To load media to one of the internal media channels, drag it to the Media player. The 
media is now available to play when this source is included in the video output.  
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Lesson 3      Mix Audio with RAVE 
System Overview 
With Graphite’s RAVE Audio Mixer, you can mix video from: 

• External sources such as microphones 
• Internal PC sources such as iTunes 
• Embedded audio from clips, XPression graphics, or input video 

With RAVE, you have the same tools as with a traditional audio mixer but with the convenience 
and additional capabilities of a virtual GUI mixer. The audio mixing components of your Graphite 
system include: 

• Hardware 
Dedicated professional grade twenty-eight channel hardware-based audio mixing 
engine 

• Breakout Panel 
Optional mic and line breakout panel with low distortion 
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• Software Control Interface 
The DashBoard RAVE audio GUI, accessible from any DashBoard client, has all 
the features that an audio operator would desire, including: input management, 
level monitoring, volume/gain adjustment, and more. 
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Important Audio Terms and Concepts 
If you have worked with audio before, the tools and terminology associated with RAVE will be 
familiar to you. If audio mixing is new to you, here are some important terms and concepts to 
learn: 

• Balance refers to stereo input and output and specifies the relative volume of 
sources to one another. 

• Pan refers to working with a mono input source and defines the level that goes to 
each the left and right stereo output. By controlling the balance between left and 
right sides, the sound seems to come from a certain point in sonic space.  

• Pad sets the number of decibels to automatically subtract from an input, making it 
softer. This is often used to prevent overload of an amplifier downstream. 

• Gain adds decibels to a source, making it louder. 

• Sampling in digital recording is the numerical measure of the level of waveform at 
a given instant of time. Analog music is represented digitally by many samples 
taken in rapid succession. The sample rate is the number of times per second that 
samples are taken. The higher the sample rate, the more realistic the digital 
reproduction of the sound, and the higher frequencies of the sound can be 
reproduced.  

 RAVE’s sample rates of 48 Khz, 24 bits produce broadcast quality audio, higher 
than the CD standard rate of 44 Khz, 16 bits.  
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RAVE Audio Signal Flow 
In this diagram, you can see how audio signals flow from their source, or input, to the final, 
mixed output. Your system should be set up before you begin the tutorial in this section. For 
more information, refer to the appropriate product documentation. 

 

  

RAVE 
Breakout 
Box 

GRAPHITE 
Switcher 
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Mix Audio with RAVE 
For the following tutorial, you should have: 

•  two or more channels of audio configured. For more information, see the 
appropriate product documentation. 

• an audio output monitor 
In this tutorial: 

> Open the RAVE audio controls in Dashboard 
> Configure the GUI 
> Set audio levels 
> Set audio to follow video 
> Customize monitoring 
> Customize auxiliary output 

Lesson 3      Mix Audio with RAVE 

Part 1 - Configure the GUI and Set Levels 

1. To access the RAVE audio mixing GUI, do one of these: 

• If you are not already working with Graphite in DashBoard, open DashBoard. In 
the Basic Tree View, expand the Graphite entry. Within the list of Graphite 
components, expand the Graphite entry and then click Audio Mixer. 
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• OR, if you are already working with Graphite in DashBoard, click the Navigation 
Menu button at the bottom right and then click the Audio Mixer button. 

 

The audio mixing interface appears. You can see that the controls here mimic those 
on a traditional audio mixing console. Depending upon your monitor setup, you may 
need to use the Slider Bar near the bottom of the GUI to see all the channels. 

 

  
Slider Bar 
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2. Unlike a traditional, physical mixing console, you can modify what channels are 
displayed or not displayed here. Locate a channel or channels that are not in use. For 
example, in the image shown in the previous step, you can see that SDI 7-12 are not in 
use. Click the Config button at the bottom of the GUI. 

 

3. In the Main Configuration table, click to uncheck the Visible box for your unused 
channels. In our example here, those are SDI 7 – 12.   

 

4. Click the Main button to return to the virtual audio console. 
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5. Notice that the channels that you deselected in the Configuration Table no longer appear 
in this GUI. By deselecting channels that are not in use, you can see more of what you 
need without using the Slider Bar. 

 

6. Near the bottom, center, of your interface, locate the Custom and All buttons. Click the 
Custom button to see only the selected channels. Click the All button to see all the 
channels. Click the Custom button to return to the custom view. 
 

7. Near the top of the controls for each channel, there is a Balance button. By default, 
these are set to Bal: C. This means “center” and indicates that the balance of left to right 
is set at 0 for equal output to left and right stereo channels.  
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8. To adjust the balance, click the Balance button above any channel. A virtual slider 
appears. You can: 

• Move it right or left to adjust the balance.  

• Click in the Value Field. A Value Entry dialog appears. Select the number buttons 
to indicate a numeric decibel value. Then click ENTR to enter this value and close 
the dialog. 

 

• Double-click the Slider Bar to return the setting to zero, the default value. 
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9. Below the Balance Button for each channel, notice the Mute button. Click the Mute 
button. The channel remains active but is no longer audible in the output.  

 

10. Mute all active channels and notice that there is now no output. 
 

11. Click the Mute buttons again to unmute the channels. 
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12. Each channel has a Virtual Decibel Slider. Click and drag a slider up or down. The 
displayed Decibel Value changes but the volume meters do not change. This is because 
the volume of the output adjusts as you adjust the slider but the inherent decibel level of 
the input source remains the same. 

 

13. If you drag the slider for each of the active channels all the way to the bottom setting of  
-Infinity, there is no sound in the output. 
 

14. Double-click on each slider track to return the level to the default of zero. 
 
15. Click anywhere in the Virtual Slider track to instantly apply a new setting. 
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16. Click the Numeric Value field for the slider to open a Value Entry dialog. Click the 
numbers to specify the value that you want and then click ENTR. 
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Part 2 – Set Audio to Follow Video 

Audio Follows Video means that audio embedded in video remains associated with that video 
throughout the workflow from input to switcher to output. For example, if the video fades out, so 
does the audio. 

1. Beneath the Virtual Slider for each channel, locate the AFV and AFV Set buttons. 

 

2. Click to enable AFV so that audio plays with its video source.  

 

3. Set the fader to the desired level for this audio and then click AFV Set. When the 
associated video plays, the audio rises to this level. 

 

  



 

52 
 

Part 3 – Customize Monitoring 

For any input channel, you can listen to the audio at its original level without changing the 
current mixer decibel setting. You can monitor it either with or without the other audio channels 
in the mix. 

1. For one of the active audio channels, click the PFL (Pre-Fade Level) button. The button 
turns Red, indicating that you can now monitor this audio at its original input level.  
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2. In the Output channels area, notice that the Monitor channel has a blinking red light 
indicating that one or more channels are set at their pre-fade levels in the output to the 
Monitor. Levels for these channels remain as set for the output mix in the Main channel. 

 

3. Click the PFL button for another channel. This button also turns red so now both 
channels are at their pre-fade levels as you monitor them. 
 

4. Click one of the active PFL buttons to deactivate it. The button is no longer red. 
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5. With the PFL button for one channel still active and red, click the mute button for the 
other active channels. Now you hear only one channel in the Monitor, at its pre-fade 
level. 
 

6. At the bottom of the Monitor Channel controls, click PFL Clear. The red indicator light 
turns off and the PFL button that was active and red becomes inactive. 

 

7. Click the Mute buttons for those channels that you muted to deactivate muting. 
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Part 4 – Customize Auxiliary Output 

Besides output to the Main Channel, you may have additional output.  For example, you may 
output to the headset or earpiece of an on-air personality or guest.  

These additional outputs may be configured to the Aux output channels.  

1. Click one of the Aux buttons at the bottom of the GUI to access controls for an additional 
output channel. 

 

2. Notice that you have decibel level controls for each input channel just as you do for the 
Main Output channel. You can set these independently of the Main Channel.  
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3. There are also Solo buttons, just as for the Main Output channel. Imagine that one of 
your active channels is the mic for an on-air personality and that this Aux channel goes 
to his monitor. He does not want to hear his own voice. Click the Solo button for each of 
the other active channels but not the one for his mic.  

 

4. Notice that the red Solo indicator light is blinking in the Aux 1 channel controls. 
 

5. Click the Solo Clear button to clear all Solo settings. 

  



 

57 
 

Custom Controls for Audio 
You can play audio manually, as demonstrated in the preceding tutorial, or you can create 
Custom Controls to trigger audio. A Custom Control allows you to trigger one or more actions 
with a single click or button press on the Ross DashBoard ShotBox interface, the Control Panel 
or an auxiliary shot box. 

For more about creating Custom Controls for audio, see the instructions that begin on page 155. 
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Section 2: 
Streamline Common Tasks 

Section 1 covered basic instructions for accessing graphics, clips and audio content. In Section 
2, there are simple instructions for creating commands to streamline many of the tasks typically 
performed with Graphite.  

In this section: 

• Custom Controls Tutorial 1: Custom Controls and Memories 

• Custom Controls Tutorial 2: Control Commands for XPression Graphics 

• Custom Controls Tutorial 3: Take Graphics and Cut Key 

• Custom Controls Tutorial 4: Double-Boxes with XPression Graphics 

• Custom Controls Tutorial 5: Animated Wipes with XPression Graphics 

• Custom Controls Tutorial 6: Animated Wipes with a Media Wipe Transition 

• Custom Controls Tutorial 7: Chroma Key for “Green Screen” Video 

• Custom Controls Tutorial 8: Custom Controls for Audio 

• Custom Controls Tutorial 9: Set Up a Show Open Sequence 
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Tutorial 1 Custom Controls and 
Memories 

To prepare for all of the following tutorials, it is important to be familiar with the tools and 
concepts of Custom Controls and Memories. This tutorial gets you started with the basics. 

Custom Controls 
A Custom Control: 

• Allows you to save one or more actions to a single command 

• Recall the command later from single button press on your Control Panel or shot 
box, or with a single click in DashBoard’s Custom Control ShotBox. 

Custom Controls may be created and edited from the Control Panel or DashBoard. 

Memories 
A Memory: 

• Saves the current settings of the switcher 

• May include some or all parts of the switcher (one or more MEs) 

• May include some or all types of settings 
Memories may be created from the physical Control Panel or the DashBoard virtual Panel. 

It is helpful to understand that when you store a memory, you specify how the memory is 
recalled. There are three Memory Recall modes: 

• Program – All elements are recalled as stored. This is the default mode. 

•  Memory AI – This is an intelligent recall mode. Current on-air elements are   
unchanged. The transition area configures to take the on-air elements of the 
memory to air with the next transition. 

• Effects Dissolve – Specific on-air elements transition to the condition stored with 
the memory. These may include: 

> Matte colors (background, wash or borders) 
> Keyer Settings like clip, gain, transparency 
>  Mask position and size 
> Chroma key settings, except background color 
> DVE settings like size, position, aspect, border, softness, cropping 
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> Media-Store x/y position 
> Transition Progress  

Memories are explored in depth in the Carbonite Basic Training Manual. 

Key concepts in this tutorial: 

> Access tools to build Custom Controls 
> Play Custom Controls 
> Access tools to save switcher memories 

 

Tutorial 1 Custom Controls and Memories 

Part 1 – Access Custom Controls 

1. From your desktop, double-click the DashBoard icon to start DashBoard if it is not 
already running. 

 

2. In the Basic Tree View on the left, locate the Graphite system. Click the carat on the left 
to expand this item in the tree.  
 

3. Double-click Custom Control to access the Custom Control interface. If you previously 
opened Custom Control in this session, you only need to click it. 
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4. By default, the Custom Control interface opens to the virtual ShotBox. Notice the eight 
Bank buttons across the top. Select any Bank button and notice the thirty-two control 
buttons within the bank. Some of these may already be configured, or if your system is 
new, they may all be blank. Once Custom Controls are configured, you can operate 
them from here. 

 

5. At the bottom left of the interface, click the Editor button. The Editor interface appears. 
This is where you can set up Custom Controls. 
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6. From the list of banks on the left, you can select the Bank that you want to use for a new 
Custom Control. In the example here, Bank 7 is selected. 

 

 You may want to organize your custom controls in a way that is useful for your 
needs. For example, you may want all the controls for a certain program in one bank or 
all the controls for audio in one bank.   
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7. From the Custom Control menu column, at the right in the Custom Controls area, select 
a Custom Control. In the example here, Custom Control 1 is selected. The command or 
commands that you choose in the following steps are assigned to the selected Custom 
Control. 
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8. Click the Modify Event List button, near the bottom right of the interface.  

 

Once you click Modify Event List, the interface offers tools to select the device or devices you 
want to control and what you want them to do. In each of the remaining tutorials in this book, 
you can use the steps here to get started, and then add commands to create some of the most 
common types of Custom Controls. 

Once you finish building the commands in a Custom Control, you can name the Custom Control 
in the field at the top, just to the left of the Record button. Then, the name appears in the 
DashBoard ShotBox. 

Part 2 - Work with Memories 

For some of the following tutorials, you need to create a Memory. Traditionally, Memories are 
saved from the physical Control Panel. To access the tools to save Memories in DashBoard, 
follow the steps here. 

1. In Dashboard, from the Main Menu, click Views>Basic Tree View if the Basic Tree View 
panel is not open. 
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2. Expand the Graphite item in the tree and double-click Live Assist. 

 

3. At the bottom of the Live Assist interface, select Memory. 
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4. In the row of buttons just above this, select Store. 

 

Now, you can select the parameters of your memory: 

• What the memory includes 

• Where the Memory is stored 

• The Recall Mode, as discussed at the beginning of this lesson  

In some of the remaining tutorials in this book, there are specific examples and 
instructions. 

 



 

 

 

Tutorial 2 Control Commands  
for XPression Graphics 

About Control Commands 
Many of the actions that you can perform on items in an XPression sequence with your 
keyboard can also be invoked from DashBoard’s ShotBox interface. Some examples include: 

• Clear Channel 

• Take Next 

• Move Item Selection Up 

• Move Item Selection Down 

• Take Multiple Items 
Before you begin, load a project in XPression and add scenes to your sequence as needed. If 
you need practice doing this, follow the instructions that begin on page 11. 

Key concepts in this tutorial: 

> Start a new Custom Control 
> Add Control Commands for XPression 
> Name a Custom Control 
> Play a Custom Control from ShotBox 

Tutorial 2 Control Commands for XPression Graphics 

1. Access the DashBoard Custom Controls Editor. Select a Bank and an empty Custom 
Control. Click Modify Event List. If you do not know how to do this, refer to Tutorial1,  
Part 1. 
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2. In the Create/Edit Event area, click the Devices button. 

 

3. The Create/Edit Event area populates with connections to various devices. To 
communicate with XPression, select RossTalk. 
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4. The Create/Edit Event area populates with buttons for various XPression Sequence 
commands. Select the Clear Channel command.  
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5. The RossTalk Device Selection button and the Channel and Layer fields appears. Click 
the Ross Talk Device Selection and choose XPression. 
 

6. Enter the channel number and layer number that you want to clear with this command. 
For example, you can select Channel 1 and Layer 0 to clear anything on Channel 1, 
Layer 0 whenever you use this Command. 

 

 In XPression, Framebuffer indicates the scene’s playout channel. Within a single 
framebuffer, scenes can be assigned to different layers. Assigning graphics to different 
layers allows you to play more than one graphic at a time to the same channel. 
Framebuffer and layer assignments may be made as the scene is created or within the 
Sequence interface. For more about layer and framebuffer selection, refer to the 
XPression training manual. 
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7. Select Insert to insert the command above the blue highlighted line. 

 

8. Notice that there are now two commands in the Command list for this Custom Control. 
One command clears Channel 1, Layer 0 and one ends this Custom Control. You can 
add additional commands to this Custom Control.  

• To add similar commands, simply enter new values and click Insert again. In this 
example, to clear other layers on Channel 1 at the same time, with a single 
Custom Control, enter a new value in the Layer field and then click Insert. 

• To add a different type of new command, click Done and then click Modify Event 
List or click the Command Category Select button. Then, you can build a new 
command from the beginning and when done, click Insert. 

• To add a new command in the same Command Category, click the Select button 
for that category and build the command from that point. In this example, you could 
click the Devices Select button, select a device other than RossTalk and build a 
command from there. 
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9. Above the Command list, notice the Bank number. To the right of the Bank number, 
there is a Name Field for this Custom Control. By default, it displays a number to 
indicate that this is Custom Control Bank 7, Control 1. Typically, users enter a name 
here to indicate the function of this Custom Control. Place your cursor in this field and 
type CLR CH 1. Note that you are limited to 8 characters, including spaces. 

 

10. Click the Shot Box button near the bottom of the interface. The Custom Control Shot Box 
appears. Choose the Bank that has your new Custom Control. Notice that the new 
Custom Control is now available on the first button in this bank. 
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11. Click the Editor button near the bottom left of the interface. Let’s add some more 
Command Controls for XPression. From the Custom Control menu column, at the right 
in the Custom Controls area, select an unused Custom Control. 

 

12. Confirm that the Command Category is still set to Devices. Confirm that Devices is still 
set to RossTalk. 

 

13. The RossTalk setting shows the last command that you used. Click the Select button to 
see the Command Selection buttons. 
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14. Select Take Next. 

 

15. Select XPression as the RossTalk device. 

 



 

77 
 

16. Click Insert. The new command is inserted above the blue highlighted line. 
17. Enter a name for this command in the field at the top of the interface. Notice that the 

names of your configured commands appear in the Custom Controls list, to the left, as 
well as on the buttons in the ShotBox interface. 

 

18. To continue adding commands, select a new Custom Control from the Custom Control 
menu column and then repeat this tutorial, changing your selections and the command 
name as appropriate.  

 For some commands, you may need to identify a specific graphic by Take ID, 
Layer and Framebuffer. In the XPression Sequence, the Take ID is in the left column. 
The Layer is found in the layer column and the Frame buffer is found in the Output 
column. 

Once your Custom Controls are ready, click the ShotBox button and then click any configured 
button in the ShotBox to execute the command. Commands configured here may also be 
played directly from your switcher Control Panel. For more information about using your Control 
Panel, refer to the appropriate product documentation. 
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Tutorial 3 Take Graphics and Cut Key 
 

About this Workflow 
In a traditional workflow, XPression graphics are played from a sequence to one or more of 
XPression’s output channels. This output serves as the source for one or more of the keyers on 
the Graphite switcher. When you play a graphic from the sequence and cut the key on, the 
graphic appears over the background video. 

In the previous tutorial, you partially streamlined this workflow by creating Custom Controls to 
work with graphics in an XPression sequence. With the following tutorial, you can create an 
even more streamlined workflow by creating a custom command to play the XPression graphic 
and cut the key on that is populated by the XPression graphic. 

Before you begin this tutorial: 

• A project must be loaded in XPression. See Lesson 1 for more information. 
Key concepts in this tutorial: 

> Add a command to cue an XPression graphic 
> How and why to add a pause command 
> Add a command to assign XPression as the Key Source 
> Add a command to specify Key type 
> Add a command to cut a key on 

Tutorial 3 Take and Key Graphics 

Part 1 – Cue an XPression Graphic 

1. Check that XPression is running and the demo project is open. If you are not sure how to 
do this, refer to Tutorial 1. 

2. Access the DashBoard Custom Controls Editor. Select a Bank and an empty Custom 
Control. Click Modify Event List. If you do not know how to do this, refer to Tutorial 1, 
Part 1. 
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3. In the Create/Edit Event area, click Devices. 

 

4. Device buttons appear. Click to select the RossTalk button.  

 

5. Command buttons appear. Click to select Take Next. 
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6. Click the RossTalk Device Selection button and then click to choose your XPression 
device.  

 

7. Click Insert. 

 

8. Notice that this command is now in the Command List for this Custom Control. 

 

So far, this Custom Control will select the next graphic in the sequencer playlist and 
cue it to XPression’s output. To further streamline your work, you can add to this 
custom control so that it not only cues and plays the graphic but also cuts to air the 
key to which it is assigned. 
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Part 2 – Add a Pause to Allow the Key to Clear 

1. Click Done. 

 

2. Click Modify Event List. 
 

3. In the Create/Edit Event area, choose Special. 
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4. You want to insert a pause to allow the key to clear properly. From the Command 
selection buttons, choose Pause. 

 

5. The Pause Duration field appears. The duration is expressed in frames. Click this field to 
open a Value Selection dialog. Change the Pause duration to 2 frames and then click 
ENTR. 
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6. Confirm that the End Event is selected in the Command List and then click Insert. 
 

7. The Pause event appears in the Command List for this Custom Control. 

 

 When you click Insert, you place the new command before the selected 
command, indicated with a blue highlight. If you had the Take Next command selected, 
then your Pause command would be in the wrong order. A good practice is to insert 
commands in the desired order and always confirm that the End command is selected 
before you click Insert. 

Part 3 – Assign XPression as the Key Source and Add a Pause 

Next, add an event to the Custom Control to assign XPression as the source for a key.  

1. In the Create/Edit Event area, click the Select button for Command Category. 

 

2. The Command Category Selection buttons appear. Select Switcher. 
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3. From the Switcher commands, select Bus Source. 

 

4. To define this source, you need to make several specifications: 

• Click the ME Selection button and choose the Program ME. Typically, this is  
ME 2. Note that some of our examples may vary. Check your system configuration 
and modify the tutorials accordingly. 
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• Next, click the Bus/Keyer selection button and choose the key (1-4) that you want 
to use for XPression graphics. In the example here, Keyer 1 is selected. 

 

• Leave Bus set to Video. 

• Click the Source selection button and then choose XPression. 

 

5. In the Command List, click to select the End event. Remember, when you insert an 
event, it appears above the selected item. 

6. Click Insert. 

We need to add another Pause in the Command List. 

7. In the Create/Edit Event area, Click the Select button for Command Category and then 
click Special. 
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8. From the Special commands, click to choose Pause. Change the Pause duration to 2 
frames, and then click Insert. 

Your Command List for this Custom Control now has five events: Take Item, 
Pause, Bus Source, Pause and End. 

Part 4 – Add a Command to Specify Key Type and Add a Pause 

1. Click the Command Category Select button. 
 

2. Select Switcher as the category. 
 

3. From the switcher commands that appear, select Keyer. 

 

4. From the Keyer commands that appear, select Keyer Type. 
 

5. Make sure that the correct ME and Keyer are selected. These should be the same as 
you selected before when you assigned XPression as the source. 
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6. For Type, choose Auto Select.  

 

 Auto Select is the key type typically used for graphics. This key type indicates 
that the graphic is full frame and its transparent areas are keyed out so that you can see 
the video behind it. For more about key types, refer to the appropriate product 
documentation. 

7. With the End event selected in the Command List, click Insert. 
 

8. In the Create/Edit Event area, click the Select button for Command Category and then 
click Special. 

 
9. From the Special commands, click to choose Pause. Change the Pause duration to 2 

frames, and then click Insert. 

Part 5 – Add a Command to Cut the Key On and Add a Pause 

1. Click the Command Category Select button. 
 

2. Select Switcher as the category. 
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3. From the switcher commands that appear, select Keyer. 

 

4. From the Keyer commands that appear, select Keyer Active. You want to make sure the 
Keyer is in the video output of the switcher so that the graphic effect is visible. 

 

5. Make sure that the correct ME and Keyer are selected. These should be the same as 
you selected before when you assigned XPression as the source. 
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6. For Parameter, select Cut Key. For Change Type, select Absolute. For Value, select On. 

 

7. Don’t forget to confirm that the End event is selected in the Command List, then click 
Insert. 

You can modify this tutorial as needed. For example, add commands or additional 
custom controls for a hold, cut the key off, or advance to the next graphic. 

8. In the Name field near the top of the interface, enter a name for this Custom Control that 
indicates its function. 
 

9. You can run your Custom Control either from your Control Panel or from DashBoard by 
selecting the ShotBox button at the bottom left. 

 

  



 

 

 

 

Tutorial 4 Double-Boxes with 
Graphics 

About Double-Boxes 
A commonly used format for displaying two video or image sources is called a “double-box” or a 
“two-box.” 

 

The XPression Demo project that you worked with in earlier tutorials includes a scene that is 
designed for a two-box. In the following tutorial, you can use this or any similarly designed 
graphic and assign two video sources as the sources for DVE keys. You can then position the 
DVE keys so that they are framed by the boxes in the graphic and store the entire effect to a 
memory. In the final part of this tutorial, create a Custom Control to recall the effect and the 
graphics to Preview. 

 In the image above, the video in each box appears rotated, but it is not. This is 
an illusion created with dimensionality in the overlay graphic that works well with 
panoramic views like the ones shown here. Please note that the DVE keyer on the 
Carbonite switcher can manipulate scale and position, but not rotation. 
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Key concepts in the following tutorial: 

> Temporarily load an XPression scene to the background as a guide for 
positioning DVE keys 

> Create, size and position two DVE keys on the switcher for a “double-box” 
> Create a key to position the double-box graphic over the two DVE keys 
> Save an effect as a memory 
> Create a double-box Custom Control 

Tutorial 4 Double-Boxes with Graphic 

Part 1 – Load the XPression Scene for the Background 

1. Open the XPression demo project if it is not already open. If you are not sure how to do 
this, refer to Lesson 1. 
 

2. Look through the XPression sequence, and make sure that a scene designed as a 
double box is in the Sequence list. If not, locate a double box scene in the Scene 
Manager and drag it to the Sequence List.  

 

3. Once this scene or another suitable double-box scene is in the Sequence List, double-
click it in the Sequence list to load it to the framebuffer. This scene should now appear in 
the monitor for XPression. 
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Part 2 – Set Up the Double-Box on the Switcher 

Your Graphite system’s switcher functions may be controlled with a physical Control Panel or 
with DashBoard’s virtual Control Panel. In some of the following instructions, DashBoard steps 
are presented as the first alternative for each step and the corresponding instructions for the 
physical Control Panel are offered as the second alternative.  

1. To access switcher controls, do one of these: 

• Start DashBoard from the desktop icon if it is not already running. Expand the 
items in the Basic Tree view and locate your Graphite system. Expand the 
Graphite item in the tree and then double-click Panel. 

 

 

 You may want to click X at the top of the Basic Tree View panel and any other 
Views open in this area to have a complete view of the virtual Control Panel. You can 
always open the Basic Tree View again from the Main Menu by clicking Views>Basic 
Tree View. 

• Power on the Control Panel if it is not already on. 
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2. We want to display the XPression two-box scene so that we can use it as a guide for 
sizing and positioning the two boxes. To designate the XPression two-box scene as the 
background, do one of these: 

• In DashBoard: 
> near the top left of the virtual Panel, click ME1. With this selection, the 

controls displayed affect ME 1. 
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> To assign XPression as the source for the background on ME 1, in the 
Program bus (middle row of buttons), click the button for XPression. In the 
example here, it is labeled CG1. 

 

> Click ME 2. Now all the controls displayed affect ME 2. 
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> In the Program bus, click ME 1 as the source for ME 2. This allows you to 
monitor this project as you build it. 

 

• On the physical Control Panel: 
> In ME 1, press the button associated with XPression in the Background Bus 
> In ME 2, press the button associated with ME 1 in the Background bus  

For simplicity, as we continue our instructions we may use either DashBoard or the Control 
Panel only, but feel free to explore the comparable controls if you wish. 

3. Let’s create a key to position in one of the two boxes. In the DashBoard Panel, 
Transition Parameters area, select ME1 and then Key 1. 

 Until you make these selections, you may not see all of the buttons shown here. 
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4. Click DVE Key to specify that this is a Digital Video Effect, or DVE, key. This means that 
you can resize and reposition it to key it over other images or video. 

 

5. In the Bus Delegation area, make sure that ME 1 and Key 1 Sel are selected. If you do 
not see these, make sure that ME/Key is selected. 
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6. Select a video source in the Key bus. This is the top row of the three long rows of 
buttons near the bottom of your screen. In the example here, Video C is selected. 

 

7. To cut the key on, do one of these: 

• In DashBoard, click the Cut button next to the DVE Key button 

 

• On your Control Panel, press the Key 1 Cut button, near the Fader bar for ME1. 
Now in your output monitor, you should be able to see video over your 2-Box graphic. 
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8. To size and position the image, do one of these: 

• In DashBoard, click and drag the virtual sliders and dials at the top right of the 
interface.  

 

In each pane, the slider and the dial do the same thing. Their functions, from left to 
right are: 

> Scale 
> Move left or right 
> Move up or down 
> Squeeze 
> Soften edge 
> Add and size border 

 Click the color buttons below the Add Border control to specify a border color. 
Right-click the large color square for advanced color controls. 

> Crop left 
> Crop right 

• On your Control Panel: 
> Twist the joystick to scale the video 
> Move the joystick left, right, up or down to position the video 
> Refer to the mnemonic display window. You may see labels there for scale, 

position, cropping and borders. Use the dials below this window to adjust 
these parameters. Use the Next button to see other parameters in the 
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mnemonic display. Press the Key 1 Sel button, above the Key delegation 
bus, to reset this menu. 

 For more information about using your Control Panel to add borders or soften 
edges, refer to the product documentation or the Carbonite training manual. 

You can experiment with these controls. Then, make sure your video is over the box on the left. 
If you have added borders or soft edges, you can remove these. For this tutorial, the graphic will 
eventually be in front of the video boxes, so the edges will not show. 

To make a second box, you can repeat the steps to make the first box and then reposition it, or 
you can simply copy the first box as described in the next step, ensuring that your two boxes are 
the same size and aspect ratio.  

9. To copy the first box, in ME1 on your physical Control Panel, press and hold the Key 2 
Sel button. While you are pressing it, press and release Key 1 Sel and then release Key 
2 Sel.  

 In general, to copy Keys, press and hold the destination while you press and 
release the source. 

10. Cut Key 2 on, either from DashBoard or your Control Panel. 

 

It won’t look like there is a new box, because it is positioned directly over Key 1. 

11. Use the controls in DashBoard or the Control Panel joystick to move Key 2 to the right 
and position it appropriately over the box in the graphic. You do not need to scale it or 
move it up or down. Part of the efficiency of copying it is that it is already the correct size 
and in the correct Y position. 
 

  



 

101 
 

12. With the Key 2 Sel button still selected, do one of these to select a fill source: 

• In DashBoard, Click the Key Fill button and from the Key Fill Source dialog, select 
a source for this Key. 

 

• Or, in DashBoard, change the Bus Delegation selection to Key 2 Sel and choose a 
source from the Key bus. 

 

Now we are ready to place the graphic in front of the two video boxes. 

13. In the Key Parameters area, select Key 3 and click Auto Select as the key type. 
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14. Select Key 3 Sel in the Bus Delegation area.  

 

15. From the Key Bus row, select the button assigned to XPression. In our example, it is  
CG 1. 
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16. In the Key Parameters area, click Cut to cut this key on. Since it is Key 3, it appears in 
front of your two boxes, Key1 and Key 2. 

 

 

Part 3 – Save this Effect as a Memory 

Now you are ready to save this effect in ME 1 to a Memory.  

1. In Dashboard, return to the Basic Tree view and open Live Assist. In Live Assist, choose 
Memory>Store. If you are not sure how to do this, refer Tutorial 1, Part 2. 

 
2. In the Inclusions area, select ME 1 at the top left, to only store ME 1’s effect. Note that 

selected items are in color. If you need to deselect an item, you can click it. 

 

3. In the Memory Store area, pick the Memory bank, 0-9, where you want to store this 
memory.  

4. Within this Memory Bank, pick this Memory Location, 0-9 for this memory. In the 
example here, Bank 0 and Memory 0 are selected. 
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 You may want to have an organized plan for storing memories so that they are 
easy to locate.  

5. Click the Store button at the end of the Memory Store row. 

 

Part 4 – Create A Custom Control for a Double-Box 

Now you are ready to start creating your custom control. You will need the Take ID for the 
XPression 2 Box graphic. If you do not remember it, open XPression’s Sequence interface. The 
Take ID is in the Sequence List in the row for that graphic, on the left. 

 

 

1. Access the DashBoard Custom Controls Editor. Select a Bank and an empty Custom 
Control. Click Modify Event List. If you do not know how to do this, refer to Tutorial 1, 
Part 1. If the Modify Event List Button is not present, click the Done button to reset the 
interface and then you should see the Modify Event List button. 
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2. In the Create/Edit Event area, select Devices. 

 

3. Select RossTalk. 

 

4. Select Take (3). 

 

5. Click the RossTalk Device selection button. 
 

6. From the Select RossTalk Device dialog, select the XPression. 



 

106 
 

 

7. Click the Take ID field. In the Number Keypad that appears, type or enter the Take ID of 
the 2 Box graphic and then click ENTR. 

 

8. Click the Channel field. In the Number Keypad that appears, enter the playout channel of 
XPression for this graphic and then click ENTR. Typically, with Graphite, you only have 
one XPression channel, but if you have additional channels, you can use this setting to 
override any settings made in XPression. 
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9. Click the Layer field. In the Number Keypad that appears, enter the Layer within the 
channel’s framebuffer of XPression for this graphic and then click ENTR. The graphic 
has an assigned layer number in XPression, but you can override that with this setting. 

 
10. Click Insert. The command to take the two-box graphic is now in the Command List for 

this Custom Control. 

 

11. Click the Command Category Select button. 

 

12. Select Special.  

 

13. Select Pause. 
 

14. Click in the Pause field. Use the Number Keypad that appears to enter a value of 2 
frames here. 
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15. Make sure that the End event in the Command list is selected and then click Insert. 

 Insert places the newly configured command above the highlighted command. 
So, if you are creating your commands in sequential order, always select End so that 
your most recent command is placed after the previous ones. 

 

16. Click the Command Category Select button. 

 

17. Select Switcher. 

 

18. Select Memory Recall.  
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19. Click the buttons next to Bank and Memory and select the Memory number and Bank on 
ME 1 where you saved the double-box memory. In our example, this is Bank 0, Memory 
0.  

 

20. Make sure the End event is selected in the Command List and then select Insert. 

 

21. Insert a Pause as before, by selecting Command Category, then Special and then 
Pause.  
 

22. Set the Pause to 2 frames. 
 
23. Confirm that the End event is selected in the Command List and then click Insert. 

 

We want the two-box to load to Preview before it plays to Program. 

24. Select Command Category. 
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25. Select Switcher, and then select Bus Source.  
 
26. Click the ME button and select ME 2. 
. 
27. Select Preset as the Bus/Keyer. 

 
28. Select ME1 as the source. 

 

 

29. Click Insert. 
 

30. Click Done. 
31. Remember to type a name for your Custom Control on the button near the top of the 

interface, so that you can locate this Custom Control in the Shot Box. 
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Part 5 – Play Your Double-Box Custom Control 

1. To run your custom control, select the Navigation Menu button at the Bottom right, and 
then choose Custom Control. 
 

2. At the bottom left of the Custom Control interface, choose the ShotBox button. 
 

3. The ShotBox appears and you can select the appropriate Bank. 
 

4. Click the appropriate Custom Control button to play the double-box. 
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Tutorial 5 Animated Wipe with 
XPression Graphics 

About Animated Wipes with XPression Graphics 
Wipes are commonly used to open a program or to transition between segments. A wipe is a 
short animated graphic or clip that plays over a video source. As the wipe covers the current 
video source, there is a transition to the next video source. As the wipe ends, the next video 
source is revealed. 

   

   

You can create a Custom Control to run an animated wipe from XPression. This effect cues and 
plays the animation, then cuts to the source you have selected in Preview. 

Key concepts in the following tutorial: 

> Assign XPression as key source with a Custom Control command 
> Use pauses in Custom Controls 
> Timing pauses with an animated wipe 
> Transition video from Preview to Program with a Custom Control 
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Tutorial 5 Animated Wipe with XPression Graphics 

Part 1 – Locate the Animated Graphic 

1. Open XPression and access the Sequence interface. Open your own project or open: 

D:\Projects\ROSS NEWS EVENING – GRAPHITE 

If you are not sure how to do this, refer to Lesson 1, Load XPression Graphics. 
 Make sure that there is an animated wipe graphic in the Sequence List. If you are 
using the ROSS EVENING NEWS project, you can use: 

TRANSITION TEXT QUICK 

2. If the graphic is not in the Sequence List, click and drag the graphic from the Scene 
Manager to the Sequence List. 

 

3. Make a note of the Take ID, the Framebuffer and the Layer number. All this information 
is in the row for this item in the Sequence list. You need this information later to set up 
the Custom Control. 
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Part 2 – Begin Building the Custom Control 

1. Access the DashBoard Custom Controls Editor. Select a Bank and an empty Custom 
Control and then click Modify Event List. If you do not know how to do this, refer to 
Tutorial 1. 
 

2. You need a command that tells XPression to clear the channel. Select Devices. 
 

3. Select RossTalk.  
 

4. Then select Clear Channel. 

 

5. Click the Ross Talk Device Selection button. 
 

6. From the Select Ross Talk Device dialog, click XPression. 
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7. Click the Channel field and then use the Channel Numeric Entry Pad to specify the 
channel (Framebuffer) you want to clear with this command. Typically, this is Channel 1, 
since most Graphite systems offer one XPression channel. 

 

8. Click the Layer field and then use the Layer Numeric Entry Pad to specify the layer you 
want to clear with this command. Use the same layer number as the XPression graphic 
that you plan to use.  

 

9. Click Insert. This command appears in the Command List at the top of this interface. 
 

10. If you want to clear additional layers, simply change the Layer field entry and click Insert 
again. 
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Part 2 – Add a Pause 

Next, insert a pause to allow the key to clear properly.  

1. Click the Category Command Select button. 

 

2. Click Special. 

 

3. Click Pause. 

 

4. Change the Pause to 2 frames. 
 

5. Make sure that the End event is selected in your Command list and then click Insert. 

Part 3 – Assign the XPression Key Source to the Key 

So far, we have a command to clear the channel and a pause to ensure that the channel clears. 
The next event to add to the command list assigns XPression as the key source.  

1. Click the Command Category Select button. 
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2. Select Switcher, since this command is an action for the switcher to perform. 

 

3. Select Bus Source. 

 

4. Click the ME selection button and then from the Select ME dialog, choose your Program 
ME. 
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5. Click the Bus/Keyer Selection button and choose a Keyer (1-4) for your XPression key.  

 Keyers layer in order over the background. Keyer 1 is in front of the background, 
Keyer 2 is in front of Keyer 1 and so on. The best choice for a media wipe is Keyer 4 
since its output renders in front of all other Keyers. 

 

6. Next to the Bus label, select Video. 
 

7. Click the Source Selection button and choose XPression. 

 The device labels in the Select Source dialog are specifically configured for your 
facility. Your XPression may have another name, such as CG 1 or Graphics.  

8. Make sure that the End event is selected in your Command list and then click Insert. 
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Part 4 – Add Another Pause 

To allow the previous command to complete, add another pause by repeating the steps in  
Part 2 of this tutorial. 

Part 5 – Cut On the Key 

So far, this Custom Control includes commands to clear the channel and to specify that 
XPression populates a key. We also have pauses to allow these things to happen. Next, add a 
command to cut the key on. 

1. Click the Command Category Select button. 

 

2. Select Switcher. This command affects the switcher. 

 

3. Select Keyer. 
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4. Select Keyer Active. You want to specify that the keyer is in the output when the 
XPression graphic plays so that the transition is visible. 

 

5. Click the ME Selection button and choose the Program ME. 
 

6. Click the Keyer button, and then click to select the Keyer that you specified earlier for 
XPression.  
 

7. Click the Parameter label, select Cut Key. 
 

8. Click the Change Type Label and select Absolute. 
 

  



 

122 
 

9. Click the Value Label and select On. 

 

 
10. Make sure the End event is selected in the Command list. 
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11. Click Insert. 

 

Part 6 – Add Another Pause 

To allow the previous command to complete, add another pause by repeating the steps in Part 
2 of this tutorial. 

Part 7 – Call Up the Correct Graphic 

So far, there are commands in this Custom Control to clear the XPression channel, specify a 
key for XPression and cut the key on, along with pauses to allow these things to happen. We 
also need a command to specify the XPression graphic to play. 

1. Click the Command Category Select button. 
 

2. Click Devices. We want to specify that this command acts on the XPression. 
 

3. Click RossTalk. 
 

4. Select Take (3). Take (3) allows you to make three specifications- Take ID, Channel and 
Layer. 

 



 

124 
 

5. Click the RossTalk Device selection button. From the Select Ross Talk Device dialog, 
choose the XPression. 
 

6. Click the Take ID field and enter the Take ID for the transition or media wipe graphic. 
Remember the Take ID is in the XPression Sequence list in the left column. 

 

7. Click the Channel field and enter the XPression playout channel. Typically, this is 
Channel 1 unless your system has special options. 
 

8. Click the Layer field and enter the Layer number where the XPression scene plays in the 
designated channel. The Layer number is listed in the XPression Sequence list, to the 
right of the scene name. 

 You can see at a glance or modify Framebuffer (Channel) and Layer settings in 
the XPression Sequence interface. With the scene selected in the Sequence list, look at 
the Take Item Inspector, near the bottom of the interface and click the Take Item tab. 

9. Confirm that the End event is selected in the Command list and then click Insert. 

 To load multiple graphics on the same channel, assign them to different layers in 
XPression. Use the same settings in this part of the tutorial. Simply change the Layer 
number and click Insert again to add commands. 
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Part 8 – Add a Pause to Allow the Program Video to Cut 

Add a pause for the duration of the XPression graphic from its start until it is full screen. When it 
is full screen you can cut to the next program video source without the cut being visible.  

1. Click the Command Category Select button and click Special. 
 

2. Click Pause. 
 

3. Enter a duration in frames equal to about half of the total length of the graphic’s 
animation.  

 

4. Confirm that the End event is selected in the Command List and then click Insert. 

Part 9 – Transition Video 

Next is the command to cut the underlying video. 

1. Click the Command Category Select button and click Switcher.  
 

2. Click Transition. 
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3. Click ME Trans Action. 

 

4. Click the ME Selection button and choose the Program ME. In the example here,  
ME 2 is selected, but yours may be different. 

 

5.  Click the Action button and choose Cut. 

 

6. Confirm that the End event is selected in the Command List and then click Insert. 
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Part 10 – Add a Pause to Allow the Animation to Finish 

Repeat the steps in Part 8 of this tutorial, or use the Tip here. 

Part 11 – Cut the Key Off 

Finally, when the transition is complete, we need to cut the key off. 

1. Click the Command Category select button and click Switcher. 
 

2. Click Keyer. 
 

3. Click Keyer Active. 
 

4. Click the ME Selection button and choose the Program ME. 
 

5. Next to the Keyer label, select the Keyer that you cut on in an earlier command. 
 

6. Next to the Parameter Label label, choose Cut Key.  
 

7. Next to the Change Type label, select Absolute. 
 

8. Next to the Value Label, select Off. 
 

9. Confirm that End is selected in the Command List and then click Insert. 

  

RossTip!  

You can not copy and paste events in the Command List, but you can use this trick if you 
want another command similar to one you already entered.  

1. Click the command in the list that you want to copy.  
2. Click Edit Event. You are not actually going to change this event, but now the settings 

for this event populate the Create/Edit Event area. 
3. Click to select the End event in the Command List. 
4. Click Insert. A copy of the previously selected command is now in the list.  
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Part 12 – Complete this Custom Control 

1. Click Done. 

 

2. Select the Placeholder name for this Custom Control at the top of the interface and type 
a new name. The name you enter here appears on the virtual ShotBox button, so 
choose a name that indicates function, such as XP WIPE. 
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3. To test your Custom Control, click the ShotBox button at the bottom left. In the ShotBox 
open the Bank for this Custom Control. Make sure you have a video source selected for 
your Program ME and your Preview ME. Remember, you can do this either from the 
physical Control Panel or DashBoard’s virtual Panel. Click the Custom Control button in 
the ShotBox to see your effect play. 

 

 If the timing is not quite right, try adjusting the length of the Pause commands. 
Select a command in the Command List and then click Edit Event. Adjust the settings in 
the Create/Edit event area and then click Replace. 
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Tutorial 6 Animated Wipes with a 
Media Wipe Transition 

About Animated Wipes with a Media Wipe Transition 
A Media Wipe is triggered directly from the transition area on your switcher. Unlike the animated 
graphic wipe described in the previous tutorial, a media wipe automatically transitions in front of 
all other sources including keys and background. You do not need to assign it to a key.  

Media wipes may be video or a series of images (.tga or .png files that play in sequence to 
create animations) stored on a USB drive. A common workflow is to store all media needed for 
a specific program on a USB drive and insert the drive to the Graphite frame whenever you 
prepare for the program.  

Media wipes may be media that you purchase or create with other applications. Or, you can 
export animated wipes from XPression as image sequences. 

Key concepts covered in the following tutorial: 

> Create a media wipe (.tga series) from an animated XPression graphic 
> Access the wipe in DashBoard’s Media Manager 
> Create a Custom Control to play a media wipe 

Tutorial 6 Animated Wipe with a Media Wipe Transition 

Part 1 – Prepare the Media Wipe 

You may have a media wipe that you can use for this tutorial already loaded on a USB drive. If 
not, follow the steps here to prepare one from an animated XPression graphic in the sample 
package on your system. 

1. Open XPression. 
 

2. Add a scene suitable as a wipe, such as Transition Text Quick, to the Sequence List. If 
the scene has any text or images that you want to replace, select the scene in the 
Sequence List and then make your changes in the Take Inspector. If you need to review 
this process, refer to Lesson 1, near the beginning of this manual. 
 

3. Right-click the scene in the Sequence List. 
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4. From the menu that appears, choose Export Take Item To>Images or Export Take Item 
To>Video.  

 

5. In the Export to Images or Export to Video window that appears, click the Browse button 
beside the Target Folder field. Locate a folder for your media. If you are creating an 
image series, add a sub-folder specifically for these images. Click the Folder in the 
Browse window and then click Select Folder. The full path appears in the Target Folder 
field. 
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6. Make selections from the File Format and Codec dropdowns to specify the type of file 
you want to create. 

 

7. Check the other settings and make sure they are correct and then click Export. 
 

8. Once the Export is complete, click Close to exit this window. 
 

9. Locate the folder with your new .tga images and copy it to a USB drive. 

 For convenience, you can use a third-party file transfer software, such as FileZilla 
to add files to the USB from another network location, without removing the USB from 
the Graphite frame. This workflow is explored in depth in the Carbonite Basic Training 
Manual. 

10. Insert the USB drive into the USB port on your Graphite system. 

Part 2 – Prepare to Access a Media Wipe Clip and Locate the Media Wipe Number 

1. Make sure you have an appropriate animated wipe loaded on your Graphite system or 
on a USB inserted into the Graphite system.  
 

2. Open DashBoard. 
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3. In DashBoard, to open the Media Manager, do one of these: 

• Click the Navigation Menu button at the bottom right of the screen and then select 
Media Manager.  

• In the Basic Tree View on the left, expand the Graphite entry and double-click 
Media Manager if you have not previously opened it in the current session or 
simply click it if you have already opened it. 

4. On the top left side of the Media Manager interface, select the folder that contains your 
wipe. Then, click the wipe once to select it.   

5. Look in the Item Details area, locate the Media Number and make a note of this number. 
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Part 3 – Start a New Custom Control and Enter a Command to Load the Media Wipe 

1. Next access the Custom Control interface, select a bank and an empty Custom Control 
and then click Modify Event List. If you do not remember how to do this, refer to the 
basic Custom Control tutorial on page 62 
 

2. Click the Command Category Select button. 
 

3. Click Switcher. 
 

4. Click Media Store. 
 

5. Click Load. 
 

6. Next to the MediaStore Channel label, select the channel (1-4) where you want to load 
the wipe. In this example, M1 is selected. 

 
7. Next to the Location label, click Internal or USB to specify the location of the media wipe 

clip. 
 

8. Click the Media Number field and enter the Media Wipe number that you located in the 
first part of this tutorial. In this example, the Media Number is 7. 

 

9. Click the Insert button at the bottom of this interface. The command to load the media 
wipe to a media channel is inserted in the Command List near the top of the interface. 
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Part 4 – Add a Pause 

Next, add a pause to allow the switcher to load the wipe.  

1. Click the Command Category Select button. 
 

2. Click Special. 
 

3. Click Pause. 
 

4. If the Pause is already set to 2 frames, then leave this setting. If not, click in the Pause 
field and change the value to 2 frames. 

 

5. Confirm that the End event is selected in the Command List above and then click Insert 
to add the pause to the list. 

Part 5 – Select the Wipe in the Transition Area 

1. Click the Command Category Select button. 
 

2. Click Switcher. 
 

3. Click Transition. 
 

4. Click ME Trans Type. 
 

5. Next to the ME label, select the current Program ME, typically ME 2, where you want to 
run this transition.  

  



 

137 
 

6. Next to the Type label, select how you want the transition to happen. Choose Media 
Wipe. 

 

7. Confirm that the End event is selected in the Command List and then click Insert. 

Part 6 – Add a Command to Play the Media Wipe 

1. Click the Command Category Select button. 
 

2. Click Switcher. 
 

3. Click Transitions. 
 

4. Click ME Trans Action. 
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5. The ME Trans Action settings appear.  

• Select the ME. 

• Set the Action to Auto Trans. 

6. Confirm that the End event is selected in the Command list, and then click Insert. 
 

7. Click Done. 
 

8. Click the Custom Control Name button at the top of this interface and type a name for 
this Custom Control that indicates its function. 

 

9. To test your new Custom Control, click the ShotBox button at the bottom left. Select the 
bank that has this Custom Control and click the Custom Control button with the name 
that you entered in the previous step. 

 It takes some time for the Media Manager to load an animation for the first time in 
a session. To avoid delays during a broadcast, pre-load the animation in the Media 
Manager even if you plan to play it with Custom Controls. Once you have loaded it, you 
do not have to keep it in the Media Channel; it remains loaded in RAM, ready to be 
recalled. 

 

  



 

 

 

Tutorial 7 Chroma Key for “Green 
Screen” Video 

About Chroma Keys 
A chroma key creates transparency in all areas of an image or video that are a specified color. 
Any image or video behind the media assigned to a chroma key is then visible through the 
transparent area. A common use for this type of key is to have a presenter in front of a green 
screen and then apply the key, removing the color green, so that the presenter appears in front 
of a different background. However, a chroma key can be based on any color. 

Graphite’s UltraChrome chroma key makes automatic adjustments, but some manual 
adjustments may be needed once the key initializes.  For the best results, initialize the key first, 
and then identify the areas where you need to adjust the key. 

For adjustments, there are two chroma key modes, Basic and Advanced. For either mode, the 
initial procedure is the same, but the advanced mode offers more fine-tuning options. Once we 
create a key, we can explore those options. 

Key Concepts in this tutorial: 

> Create a chroma key with DashBoard Live Assist 
> Adjust a chroma key 
> Apply a mask to a chroma key 
> Create a Custom Control to trigger a chroma key 

Tutorial 7 Create and Use a Chroma Key 

Part 1 – Prepare a Source 

1. In DashBoard, do one of these to open the Media Manager: 

• Click the Navigation Menu Button and then choose Media Manager. 

 

• In the Basic Tree view, expand the Graphite entry and then double-click Media 
Manager or click once if you have previously opened it in this session. 
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2. In the Media Manager, Browse tree, expand Internal>Samples and choose the sample 
folder suitable for your video format. 

 

3. Drag the file Anna CK, or any other “green screen” video that you want to use to M1. 
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4. Look at the Item Details Pane and make a note of the Media Number. 

 

Part 2 – Set up the Chroma Key 

1. In DashBoard, do one of these to access the LiveAssist interface: 

• Click the Navigation Menu button and then choose Live Assist. 

 

• In the Basic Tree view, expand the Graphite item. Double-click the Live Assist item 
in this list to initiate it if you have not used it previously in this session or just click it 
if it is already initialized. 
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2. In the Live Assist interface, near the bottom left, select the ME that you want to use for 
this effect. In the example here, ME 1 is selected. 

  

 You can also use this procedure for a MiniME™. For more about MiniMEs, refer 
to the product documentation or Ross U training videos at rossvideo.com. 

3. Select the Key that you want to use. In the example here, Key 2 is selected. 

  

4. Click Key Fill button. The Key Fill Source window appears.  
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5. In this window, first select whether your source is a physical input, internal or an Aux 
Follows source. In our example, since we are using internally stored media, select 
Internal. 

 

6. Select the source with our “green screen” video. In this example, M1 is selected, since 
we loaded the sample green screen video to Media Channel 1 in the Media Manager. 
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7. Next, click Chroma Key to indicate the key type. 

 

8. Near the top left, click Advanced as the Mode setting. 

 

9. From the Color buttons at the top, click Green since this is the color that we want to key 
out of the sample video. 
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10. Click Init to initialize the chroma key.  

 

Part 2 – Set Parameters to Fine Tune the Chroma Key 

Every time the key is initialized, the switcher resets all the Chroma Key parameters to their 
default settings. For the best appearance, manually adjust these parameters specifically for the 
video that you want to key. 

1. Click the Additive Keying On or Off button. You can determine if you want more detail 
(ON) for a sharper image or less detail (OFF) to soften the edges of the chroma key and 
reduce “noise” resulting from certain lighting conditions or camera settings. 
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2. Use the Background Neg Hue slider to adjust the range of hues that are included in the 
Background, expanding counter-clockwise around the color wheel.  

 

3. Use the Background Pos Hue slider to adjust the range of hues that are included in the 
Background, expanding clockwise around the color wheel.  
 

4. Use the Background Sat slider to adjust the saturation range of the background color.  

• Increasing the saturation range value includes a wider range of saturation values 
to be included in the background. 

• Decreasing the saturation range value includes a narrower range of saturation 
values to be included in the background. 

5. Use the Edge Softness slider to add or remove edge softening of the foreground image 
and alpha channel.  

• Increasing the softness value increases the amount of softness applied to the 
foreground edges and alpha channel. 

• Decreasing the softness value decreases the amount of softness applied to the 
foreground edges and alpha channel. 
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6. Use the Foreground Clip slider to adjust the foreground clipping.  

• Increasing the clip value removes lower-saturated colors from the Foreground 
image. 

• Decreasing the clip value includes lower-saturated colors in the Foreground image. 

7. Use the Foreground Hue slider to select the central (base) color for the foreground.  

• Increasing the hue value moves counter-clockwise around the color wheel to 
select a base color. 

• Decreasing the hue value moves clockwise around the color wheel to select a 
base color. 

8. Use the Foreground Reject slider to include or reject hues adjacent to the base color.  

• Increasing the reject value decreases the amount of adjacent hues that are 
included in the foreground. 

• Decreasing the reject value increases the amount of adjacent hues that are 
included in the foreground. 

9. Use the Luminance Bkgd Luma slider to change the overall brightness of Shadow, 
Translucent, and Transition areas.  

• Increasing the background luminance value increases the brightness of 
Background, Translucent, and Transition areas. 

• Decreasing the background luminance value decreases the brightness of 
Background, Translucent, and Transition areas. 

10. Use the Luminance Reflection slider to change the brightness of semi-transparent 
reflections (like reflections from glasses).  

• Increasing the reflections value increases the brightness of semi-transparent 
reflections. 

• Decreasing the reflections value decreases the brightness of semi-transparent 
reflections. 
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11. Use the Shadow Gain slider to adjust the shadow appearance.  

• Increasing the gain value creates darker shadows. 

• Decreasing the gain value creates lighter shadows. 

12. Use the Shadow Range slider to adjust the range of the shadow colors.  

• Increasing the range value widens the shadow area by including lower-luminance 
background colors. The increased range comes because of colors moving from the 
translucent area to the shadow area. 

• Decreasing the range value narrows the shadow area by excluding high-luminance 
colors. These excluded colors move back into the translucent area. 

13. Use the Spill Clip slider to adjust spill suppress clipping.  

• Increasing the clip value removes higher-saturated colors from spill suppress 
correction. 

• Decreasing the clip value includes higher-saturated colors in spill suppress 
correction. If your foreground image contains bright-colored areas that are 
suffering from background spill, decrease the clip value to have it corrected. 

14. Use the Spill Hue slider to select the central, or base, color for spill suppress correction. 
If the color spill does not appear to be the same color as the background, use this 
control to define the hue that is "spilled" into the foreground.  

• Increasing the hue value moves counter-clockwise around the color wheel while 
selecting a base color. 

• Decreasing the hue value moves clockwise around the color wheel while selecting 
a base color. 

15. Use the Spill Reject slider to include or reject adjacent hues to the base.  

• Increasing the reject value increases the amount of adjacent hues that are 
included in spill correction. 

• Decreasing the reject value decreases the amount of adjacent hues that are 
included in spill correction. 

16. Use the Transition Gain slider to adjust the appearance of the Transition colors.  

• Increasing the gain value makes the transition area pixels more opaque. 

• Decreasing the gain value makes the transition area pixels more transparent. 
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17. Use the Translucency Gain slider to adjust the appearance of the translucent colors.  

• Increasing the gain value makes translucent colors appear more opaque. 

• Decreasing the gain value makes translucent colors appear more transparent. 

18. Use the Translucency Range slider to adjust the range of the translucent colors.  

• Increasing the range value widens the translucent area by including more hues 
from the background range (the lower-end of the range is defined by the shadow 
range you just set). 

• Decreasing the range value narrows the translucent area by excluding hues. 

Part 3 – Add a Mask to the Key 

You can use a mask to reveal only a part of the chroma key video. 

1. Click Mask. 

 

 

2. Confirm that Pattern is selected, near the top of the interface. 

 

3. You can experiment with the controls to select a pattern, invert the mask so that the 
pattern reveals the video rather than obscures it, and modify the pattern with the various 
sliders. 
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Part 4 – Create a Custom Control 
Now that you understand the steps to create a chroma key effect, you can build a Custom 
Control to do the same thing. Change the key that you have just built to something else and cut 
it off, so that after you build the Custom Control you can confirm that it really works. You can 
even change what is loaded to the Media channel in the Media Manager. This Custom Control 
will do everything. 

If you have followed the tutorials from the beginning of this book, you are familiar with the steps 
for building Custom Controls. In this section, instead of each step detailed, you will find all the 
steps to build one command listed together. For example, click Command Category 
Select>Keyer means click the Command Category Select button and then click Keyer. 

1. In DashBoard, open the Custom Control interface, choose a Bank and an empty Custom 
Control. Click Modify Event List. 

2. Next, build a command to specify that Chroma is the keyer type. Click Command 
Category Select>Keyer>Keyer Type. Choose an ME, a Keyer and set type to Chroma as 
shown here. Click Insert. 
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3. The next command loads the video to the channel in the MediaManager. Click 
Command Category Select>Switcher>MediaStore>Load. Select a media channel and 
specify Internal if you are using the internally stored sample video. Use the same Media 
Number that you located in Part 1 of this exercise. Confirm that the End event is 
selected in the Command List and then click Insert. 

 

4. The next command specifies the color to key out. Click Command Category 
Select>Switcher>Keyer>Chroma Keyer Color. Specify the ME, the Keyer choose Green 
for the Color. Confirm that the End event is selected in the Command List and then click 
Insert. 
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5. Now, we need a command to specify that the video loaded in the Media Manager is the 
source for this keyer. Click Command Category Select>Switcher>Bus Source. Specify 
the ME, the keyer, choose Video as the Bus and for source select the same media 
channel that you specified in the Load command, above. Confirm that the End event is 
selected in the Command List and then click Insert. 

 

6. Remember that when you built a chroma key before, you had to click Init to initialize the 
chroma key? Let’s build a command to do that in this Custom Control. Click Command 
Category Select>Switcher>Keyer>Chroma Key Init. Specify the ME and the Keyer. 
Confirm that the End event is selected in the Command List and then click Insert. 
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7. Finally, you need a command to cut the key on. Click Command Category 
Select>Switcher>Keyer>Keyer Active. Specify the ME and the Keyer. Set Parameter to 
Cut Key, Change Type to Absolute and Value to On. Confirm that the End event is 
selected in the Command List and then click Insert. 

 

8. Click Done. 

 

9. Remember to name the Custom Control. 

 

10. Click the ShotBox button. Locate your new Custom Control and click to play it. 
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Tutorial 8 Custom Controls for Audio 
 

About Audio and Custom Controls 
Lesson 3 in this book is an overview of audio mixing with RAVE. Various tutorials familiarize you 
with DashBoard’s Custom Controls. In addition to controlling graphics and mixer functions via 
Custom Controls, you can also control audio mixing. You can use Custom Controls for: 

• Fader level 

• balance/pan 

• aux sends 

• solo/mute/PFL 

• Gain, and -20dB Pad settings 

• Fader visibility and position in the user interface 
Key tasks covered in this tutorial include: 

> Set a Fader Level 
> Mute or Unmute 
> Clear Pre-fade listen 
> Clear Solo 

Tutorial 8 Custom Controls for Audio 

Part 1 - Set a Fader Level to Bring Audio In: 

This Custom Control sets the volume for a specified audio source to a pre-set level in a 
specified output mix. 

1. Access DashBoard. In the Basic Tree view, expand Graphite and double-click Custom 
Control. 
 

2. In the Custom Control interface, click the Editor button at the bottom left to open the 
Custom Control Editor. 

  



 

156 
 

3. Select a bank from the left column. Try to choose a bank with none of its Custom 
Controls in use so that you can put all the audio controls in the same bank.  From the 
right column, choose the first unused Custom Control. In the example here, Bank 5 and 
Custom Control 1 are selected. 

 

4. Click the Modify Event List button at the bottom right. If you do not see this button, you 
may need to click Done first to exit from a previous configuration. 
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The Create/Edit Event section offers you the controls to configure what you want to affect and 
specify details. In this Custom Control, we want to affect the RAVE Audio Mixer, and we need to 
specify the channel and indicate that we are controlling the volume. 

5. In the Create/Edit Event section, select Audio Mixer. 

 

6. Select Channel. 

 

7.  Select Volume. 
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8. To select the audio channel you want to affect, click the button labeled Inner Audio Mixer 
Channel. The Select Inner Audio Mixer Channel dialog appears. You should see buttons 
labeled for all your audio input sources. Since these are specific to your facility, they may 
be different from the ones shown here. In the example shown here, we selected C-Mic 1. 

 

9. Set the Change type to Absolute.  

 

 Absolute means that the volume is to adopt a specific value. Reset means that 
the volume it to be set at the lowest level, -Infinity. 
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10. To set the fader volume, click in the Volume field. A value keypad appears. Enter a 
decibel value and then click ENTR. 

 A value of 0 does not mean there is no volume. A value of 0 indicates unity gain 
(typically the nominal volume level) meaning that volume of the audio has not been 
changed from the source. To bring the fader all the way down, a value of -128 would be 
entered here. In this context, 128 equals infinity. 

For this example, let’s set the fader to -3dB by entering -3 in the Volume field. 

11. Finally, select a button next to Inner Audio Mixer Output to apply these settings to a 
specified output mix. You can select Main, Aux1, Aux2, or Aux3. For our example, we’ll 
select Main. The settings only affect the specified output. For example, if you apply them 
to Main, the volume in the Aux outputs remains unchanged when this Custom Control is 
triggered. 
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12. Click Insert to insert the command into the Custom Control. The command appears in 
the Command list near the top, above the blue End command. 
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13. To rename the Custom Control, select the placeholder text on the button next to the 
Bank number and type a new name. Choose a name that is not more than eight 
characters and that indicates the purpose of this Custom Control. In the example shown 
here, the name is Mic 1 Up, to indicate that this Custom Control brings  
up Mic 1. 

 

14. Click Done at the bottom right. 
 

15. At the bottom of the interface, click Shot Box. Notice that the Shot Box for this Custom 
Control Bank now offers a button to bring up Mic 1 in our example here, or the source 
you specified in your own Custom Control. 

Part 2 -  Take an Audio Source Out 

The previous Custom Control brought a source in to a mix at a pre-set decibel level. This control 
takes the same source out of the mix by assigning a decibel level of -128. Most of the steps 
here are the same as in the previous part of this tutorial except that you must pick a new 
Custom Control, choose Reset instead of Absolute for the Change type and enter a volume of -
128 Db.  

1. In the Custom Control interface, click the Editor button at the bottom left to return to the 
Custom Control Editor. 
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2. Continue to use the same bank and choose a new unused Custom Control.  If you 
began this tutorial with a completely unused Bank, choose Custom Control 2 for this 
control. 
 

3. Click the Modify Event List button at the bottom right. If you do not see this button, you 
may need to click Done first to exit from a previous configuration. 

 
4. In the Create/Edit Event section, select Audio Mixer. 

 
5. Select Channel. 

 
6.  Select Volume. 

 
7. Click the button labeled Inner Audio Mixer Channel. The Select Inner Audio Mixer 

Channel dialog appears. Choose the same input source as before, in this example  
C - Mic 1. 

 

 

8. Set the Change Type to Reset.  
 

9. Notice that now the Volume Value field is not present. You do not need to set a volume 
because Reset indicates -Infinity, as low as the volume can go. 

 
10. Finally, select a button next to Inner Audio Mixer Output to apply these settings to a 

specified output mix. You can select Main, Aux1, Aux2, or Aux3. Let’s select Main, just 
as before. 

 
11. Click Insert to insert the command into the Custom Control. The command appears in 

the Command list near the top, above the blue End command. 
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12. To rename the Custom Control, select the placeholder text on the button next to the 
Bank number and type a new name. Choose a name that is not more than eight 
characters and that indicates the purpose of this Custom Control. In the example shown 
here, the name is Mic 1 Dwn, to indicate that this Custom Control brings  
Mic 1 down. 

 

Part 3 – Mute or Unmute All 

These Custom Controls mute or unmute all sources in a specified output. 

1. Continue working in DashBoard’s Custom Controls interface. Pick a new Custom 
Control. 
 

2. If the Create/Edit Event area is not present, click the Modify Event List button.  
 

3. In the Create/Edit Event section, select Audio Mixer. 
 

4. Select Channel. 
 

5. Select Mute. 
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6. To select the audio output channel that you want to affect with this Custom Control, click 
the Inner Audio Mixer Channel button. The Select Inner Audio Mixer Channel dialog 
appears. Click the channel that you want to mute. By default, the first source is selected 
as shown here. Instead of SDI 1, we select BVS 1, so in the next image, BVS1 appears 
on this button. 

 

7. To specify where the Mute is applied, select an output mix from the Inner Audio Mixer 
Output buttons. In our example, Main is selected. 
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8. Select Absolute as the Change Type. 
 

9. To specify whether you are muting or unmuting the specified output mix, select On or 
Off. In this example, choose On. 

 

10. Click Insert to insert the command into the Custom Control. 
 

11. Because we are creating a Mute All Custom Control, we need additional commands to 
mute the remaining active audio channels. Click the Inner Audio Mixer Channel button 
again to open the Select Inner Audio Mixer Channel dialog. Select a different active 
audio channel. Leave all your other settings as they are. Click Insert.  

 
12. Repeat Step 11 for each active audio channel. Notice that the Command List near the 

top of the interface now has a Mute command for each audio channel. 
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13. Rename the Custom Control by entering Mute All in the Custom Control name field at 
the top of the interface. 

 

14. Click Done at bottom right. 
 

15. Select a new, unused Custom Control to create an Unmute All Custom Control. 
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16. Repeat Steps 3 through 14, except: 

• In Step 9, select Off instead of On 

 

• In Step 13 name the Custom Control Unmute All. 

Part 4 - Clear Pre-Fader Listen 

Pre-Fader Listen (PFL) is a monitoring mode that allows the audio mixer operator to audition the 
audio of a source in the Monitor mix as it is before fading. Thus, even if a source’s fader is set to 
-Infinity in the mix, choosing PFL sends that audio to the Monitor mix in its pre-fader condition. 
The operator can hear it even if it is not audible in the output. One or several channels can have 
PFL enabled at once. 

Typically, as an operator prepares for a program, he may enable PFL for individual channels at 
various times as he adjusts each channel. But, once it is time for the program to begin, the 
operator wants to clear the PFL setting from all channels. A single Clear PFL command disables 
PFL for all channels simultaneously. 

1. Continue working in DashBoard’s Custom Controls interface. 
 

2. Click the Editor button at bottom left to open the Custom Control Editor if it is not already 
open. 
 

3. Select a bank, preferably the same bank that has your other audio Custom Controls. 
Select an empty Custom Control. 

 
4. Click Modify Event List at the bottom right if the Create/Edit Event controls are not 

present. 
 

5. In the Create/Edit Event section select Audio Mixer. 
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6. Select Output. 

 

7. Select Clear PFL. 

 

8. Click Insert to insert the command into the Custom Control.  
 

9. In the Custom Control Name field at the top, enter Clear PFL 

 

10. Click Done at bottom right. 
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Part 5 - Clear Solo: 

Solo is useful to isolate a single channel in a mix. When you solo a channel, all other channels 
are muted, as opposed to PFL where the other channels are not muted and the PFL signal is 
monitored through the Monitor mix. However, like PFL, this is a tool that the audio operator may 
enable for one or more channels during preparation, but needs to disable for all channels before 
a program begins. 

1. Continue working in DashBoard’s Custom Controls interface. 
 

2. Click the Editor button at the bottom left to open the Custom Control Editor if it is not 
already open. 
 

3. Select a bank, preferably the same bank that has your other audio Custom Controls. 
Select an empty Custom Control. 

 
4. Click Modify Event List at the bottom right if you do not see the Create/Edit Event area. 

 
5. In the Create/Edit Event section select Audio Mixer. 

 
6. Select Output. 

 
7. Select Clear Solo. 
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8. Click the Inner Audio Mixer Output button. From the selection dialog that appears, 
choose the output where you want to clear Solo settings. In the example shown here, we 
clear Solo in the Main output. 

 

9. Click Insert to insert the command into the Custom Control.  
 

10. In the Custom Control Name Field at the top of the interface, type CLR SOLO. 

 

11. Click Done at the bottom right of the interface. 
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Part 6 – Use Your Audio Controls 

Now you have all your Custom Controls for audio in one convenient place. 

1. Click the Shot Box button, near the bottom of the DashBoard Custom Control interface. 

 

2. The Shot Box should open to the Bank with your audio controls, since you have been 
working in this bank. If not, select the Bank from the top row of buttons. Now with a 
single click, you can complete common audio mixer tasks. 

Complex Audio Controls 
To streamline your workflow, you can create Custom Controls for other audio tasks that you 
perform on a regular basis. By now, you probably understand that any Custom Control may 
include one, several or many commands. Also, you can create memories in DashBoard’s Panel 
application to control audio.  
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Tutorial 9 Show Open Sequence 
About Creating and Running a Show Open Sequence 
Typically, at the beginning of a show, several events occur quickly, but in a predictable 
sequence that does not change from day to day. You can take advantage of the predictable 
sequence to ease the pressure of performing the events rapidly by creating a Custom Control.  

Similar situations include a throw to break or an end-of-show sequence. Custom Controls are 
useful for any of these. 

In this example, create a playlist in the XPression Sequence interface that includes graphics 
and server clips. Then, create a Custom Control to: 

•  play the show open animation 

• reveal the first server item in the playlist 

• play that item with a lower third graphic 

Tutorial 9 Show Open Sequence 

Part 1 – Build the XPression Graphics Playlist 

1. Open XPression and open a project. You can use your own project or the XPression 
demo project ROSS EVENING NEWS. If you are unsure about how to do this, refer to 
Lesson 1, Load XPression Graphics for Playout. 

2. Press F4 or click the Sequence tab if you are not already in the Sequence interface. 
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3. From the Main Menu, click Display>Clip Browser. Drag the Clip Browser from its Title 
Bar and position it below the Sequence List so that you can easily add clips to the list. 

 

4. For this tutorial, you can work with the existing playlist in the Sequence List area of your 
project, create a new group within an existing playlist or delete all the items in the playlist 
and build a new one. Add the following to the playlist: 

• TRANSITION TEXT, from the Scene Manager 

• 6 PM OPEN, from the Clip Browser 

• LW3, from the Scene Manager  

 Your open animation can be either a server clip or an XPression graphic. In this 
example, we use an animated graphic from the included demo project. 

5. Select TRANSITION TEXT in the Sequence List. In the row for this item, notice the Take 
ID, the Layer number and the Output Framebuffer. You will need this information later. 
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6. In the Take Inspector choose the Template Data tab.  

 

7. In the Objects table, expand the BREAKING ON/OFF item and select Text. Click the 
NOT-BREAKING radio button, to the right.  
 

8. Expand the TITLE object and select Text. In the field to the right, change the text to 
NEWS AT 9. Observe your changes in the Preview area, to the right of the Take 
Inspector. 

 

9. Select L3 in the Sequence List.  

10. In the Take Inspector, expand each object, select the Text object and replace the 
placeholder text in the field to the right. 
 

11. If desired, drag additional scenes from the Scene Manager to the Sequence List and 
modify them in the Take Inspector. 
 

12. Click File>Save Project. 
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Part 2 - Begin a New Custom Control 

Next, let’s begin a Custom Control to cue the first item in the XPression playlist and then 
advance through the other items in the list. 

In DashBoard, access the Custom Control Editor interface, select a Bank and an empty Custom 
Control and then choose Modify Event List. If you don’t remember how to do this, refer to the 
first tutorial, and then continue with this tutorial. 

Part 3 - Clear Graphics Channels 

The first command in this Custom Control clears the XPression channel so that it is ready to 
play the first graphic for the show open. 

1. Click Devices. 

 

2. Click RossTalk. 

 

  



 

177 
 

3. Click Clear Channel. 

 

4. Click the RossTalk Device button and from the dialog that appears, select the 
XPression. 

 

5. Click the Channel field and enter 1 if it is not already entered. Remember, your 
XPression graphics are set to play on Framebuffer 1, so this is the channel that you 
need to clear. 
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6. Click the Layer field and enter 200. You want to clear this layer because the opening 
graphic is assigned to this layer. 

 

7. Click Insert. This clear command appears in the Command list near the top of this 
interface. 
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8. Remember that your XPression playlist includes other graphics that may be assigned to 
play on other layers, so those layers need to be cleared too. In our example, the LW3 
graphic is assigned to layer 10. Click the Layer field again and change the value to 10. 

 

9. Click Insert. Another Clear command appears in the Command List. 

 

 There may be additional layers that you want to clear if your facility typically plays 
graphics on other layers and you do not want those graphics to appear with the show 
open. There may be some layers that you specifically do not want to clear, such as 
layers displaying a logo bug or other item that you want to persist in the playout. 
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Part 4 – Set Focus in the XPression Playlist 

Even though this Custom Control includes a command to play the first graphic in the XPression 
Sequence list, if another item in the list is already selected, this selection remains and 
determines how other commands, such as Take Next, function. So, it is important to make sure 
that the first item in the playlist is selected. 

1. Click the Command Category Select button. 
 

2. Click Devices. 
 

3. Click RossTalk. 
 

4. Click Focus. 
 

5. Choose the XPression as the as the RossTalk device and enter the Take ID of the first 
item in the XPression Sequence List. 

 
6. Confirm that the End command is selected in the Command List and then click Insert. 

Part 4 – Insert a Pause 

To allow the clear commands to effectively clear the XPression channel, insert a 2 second 
pause command. 

1. Click the Command Category Select button. 

 

2. Click Special. 
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3. Click Pause. 

 

4. Click the Pause field and use the numeric dialog to enter a value of 2 frames. 

 

5. Confirm that the End event is selected in the Command List and then click Insert. 
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Part 5 – Assign XPression as the Key Source 

The next command assigns XPression as the key source. 

1. Click the Command Category Select button. 
 

2. Click Switcher. 
 

3. Click Bus Source. 
 

4. Click the ME selection button and select your Program ME, typically ME 2.  
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5. Click the Bus/Keyer selection button and choose a key (1-4) for your XPression 
graphics. 

 

6. Leave Bus set to Video. 

 

7. Click the Source selection button and choose XPression as the source for this key. 

 

8. Confirm that the End event is selected in the Command List and then click Insert. 
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Part 6 – Specify Key Type 

Since Keyer 1 is for XPression graphics, its Key type should be Auto Select. This Key type 
allows images or animations with alpha (transparency) to appear in front of video with the video 
visible in the transparent areas of the graphic.  

1. Click the Command Category Select button.  
 

2. Click Switcher. 
 

3. Click Keyer. 
 

4. Click Key Type. 
 

5. Select the Program ME and choose Auto Select for the Keyer. 

Part 6 – Insert Pause 

Repeat the steps in Part 4 to insert another 2-frame Pause command. 

Part 7 – Cut the Key On 

Next, we want to insert a command to cut the key on. 

1. Click the Command Category Select button. 
 

2. Click Switcher. 
 

3. Click Keyer. 
 

4. Click Keyer Active. 

 

5. Click the ME selection button and choose the Program ME. 
 

6. Set the Keyer to the Keyer with XPression assigned as its source. 
 

7. Set Parameter to Cut Key. Set Change Type to Absolute. Set Value to On.  
 

8. Confirm that the End event is selected in the Command List and then click Insert. 
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Part 8 – Insert Pause 

Repeat the steps in Part 4 to insert another 2-frame Pause command. 

Part 9 – Cue the Open Animation 

1. Click the Command Category Select button. 
 

2. Click Devices.  
 

3. Click RossTalk. 
 

4. Click Take (3). 
 

5. Click the Ross Talk Device button and from the dialog that appears, select XPression. 
 

6. Click the Take ID field and use the number pad that appears to enter the Take ID found 
in the XPression Sequence List for the TRANSITION TEXT graphic or another graphic 
that you have in the Sequence for your show open. 

 

7. Click the Channel field and enter the Framebuffer number for this graphic. You can find 
this number in the Sequence List in the Output column. 
 

8. Click the Layer field and enter the Layer number for this graphic. This number is in the 
Sequence list in the Layer column. 
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9. Confirm that End is selected in the Command List and then click Insert.  

Part 10 – Insert a Pause 

Repeat the steps in Part 4 to insert another 2-frame Pause command. 

Part 11 – Specify the Clip Server as a Source 

The next command cues a clip to play in Preview so that it transitions as the animation finishes. 

1. Click the Command Category Select button. 
 

2. Click Switcher. 
 

3. Click Bus Source. 
 

4. Click the ME selection bus and choose the Preview ME. 
 

5. Click the Bus/Keyer selection button and choose Background. 
 

6. Click the Source button and choose your clip server channel. In this example, XP2V is 
selected, but your facility may have a different naming system. 

 

7. Confirm that End is selected in the Command List and then click Insert.  
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Part 12 – Insert a Pause 

Next, add a pause to allow the clip to finish playing as the next item opens and plays. 

1. Click the Command Category Select button. 
 

2. Click Special. 
 

3. Click Pause. 
 

4. You want this pause to be about 8 seconds, or almost the full length of the animation. 
This may be different if you are using your own graphic and it is a different length. 
Remember, the Pause is expressed in frames, so consider the frame rate for your video 
standard to determine the value for the Pause. 

 
5. Confirm that the End event is selected in the Command List and then click Insert. 

Part 13 – Take the Clip  

1. Add a Take Next command to play the clip. 
 

2. Click the Command Category Select button. 
 

3. Click Devices. 
 

4. Click RossTalk. 
 

5. Click Take Next. 
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6. Click the Ross Talk Device selection button and choose XPression if it is not already 
selected. 

 

7. Confirm that the End event is selected in the Command List and then click Insert. 

Part 14 – Insert a Pause 

Repeat the steps in Part 4 to insert another 2-frame Pause command. 

Part 15 – Transition to the Video and Graphic 

Now you need a command to play a background and the key that you set up, then transition on 
the first clip.  

1. Click the Command Category Select button. 
 

2. Click Switcher. 
 

3. Click Transition. 
 

4. Click ME Trans Elements. 

 

5. Click the ME selection button and choose the Program ME. 
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6. Click the Elements button and select Background and the key that has XPression as its 
source, Key 1 in this example. 

 

7. Confirm that the End event is selected in the Command list and then click Insert. 

Part 16 – Transition the Effect  

1. Click the Command Category Select button. 
 

2. Click Switcher. 
 

3. Click Transition. 
 

4. Click ME Trans Action. 
 

5. Click the ME selection button and then choose the Program ME. 
 

6. Click the Action selection button and then choose Cut. 
 

7. Confirm that the End event is selected in the Command list and then click Insert. 
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Part 17 – Add a Roll Clip Command 

You want to make sure that Roll Clip is turned on for the Program ME. Let’s include a command 
for that. 

1. Click the Command Category Select button. 
 

2. Click Switcher. 
 

3. Click Transition. 
 

4. Click Roll Clip. 

 

5. Click the ME selection button and choose the Program ME. 
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6. For the Value setting, click On. 

 

7. Confirm that the End event is selected in the Command List and then click Insert. 

Part 18 – Insert a Pause 

Repeat the steps in Part 4 to insert another 2-frame Pause command. 

Part 19 – Cue and Take the First Lower Third 

1. Click the Command Category Select button. 
 

2. Click Devices. 
 

3. Click Ross Talk. 
 

4. Click Take Next. 
 

5. For Ross Talk Device, select XPression if it is not already selected. 
 

6. Confirm that the End event is selected in the Command List and then click Insert to add 
this command to the list. 

Part 20 – Complete this Custom Control 

1. Click Done. 
 

2. In the Custom Control Name field at the top of this interface, replace the default name 
with a name that indicates the function of this Custom Control, for example OPEN SEQ. 
 

3. To play the Custom Control, click the ShotBox button at the bottom of the interface. 
Select the Bank where you created this Custom Control and then click the button with 
the name of this Custom Control. 
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Learn More, Do More 
Thank you for using this training manual. At Ross Video, we want to always act in your best 
interest and understand your requirements.  

In this section: 

• Learn More, Do More 

• Contact Support 

• We Want to Hear from You 

• Ross Products 
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Learn More, Do More 
Ross Video is committed to your continued learning and success. 

• Ross University is an extensive collection of online video tutorials that cover many 
of the features and operations of our products: 

> https://www.rossvideo.com/support/ross-university/ 

• The User’s Guide and other documentation for this product are helpful resources. 
You can find the latest versions on our website: 

> https://www.rossvideo.com/support/documentation/ 

• Our expert product trainers are available for onsite training suited to your needs. 
For more information or to book a training, send your request to: 

> services@rossvideo.com 

• Would you like high-end, custom graphics to support your production? Let our 
team of designers bring your vision to life or consider online purchase of graphics 
templates. Visit Ross Rocket Surgery online at: 

> https://www.rossvideo.com/services/creative/ 

• Need additional, mobile production facilities for a specific event? Consider Ross 
Mobile Production: 

> https://www.rossvideo.com/solutions/mobile-production/mobile-services/ 

Contact Support 
Our products come with technical support for the life of your Ross product: 

• 1-844-652-0645 in North America (toll free) 

• +800 1005 0100 Internationally (toll free) 

• Email techsupport@rossvideo.com 

We Want to Hear from You 
Have any ideas or comments to share? Please use the contact form here: 

https://www.rossvideo.com/contact-us/general-inquiries/ 
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Ross Products 
Did you know that Ross offers a full range of production technology products including: 

• Production Switchers 

• Control Systems 

• CG & Graphics Systems 

• Media Asset Management 

• Robotic Camera Systems 

• Newsroom Computer Systems 

• Cameras 

• Video Servers 

• Routing Systems 

• Replay Systems 

• Signal Processing 

• Social Media Management 

• Master Control Systems 

• Live Event Management 

• Multi-Viewers 

• Virtual Sets and Augmented 
Reality

Our products are used throughout the world for professional broadcast, sports, live events, 
houses of worship, education, mobile production, corporations and legislative assemblies. 

For the latest information, please visit our website.  

https://www.rossvideo.com 

We would be delighted to help you do more! 
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add 
mask to chroma key, 149 
pause to a Custom Control, 117 

animated wipe, 113 
audio 

clear pre-fade listen, 167 
clear solo, 169 
configure the GUI, 43 
Custom Controls, 155 
customize auxilliary output, 55 
customize monitoring, 52 
mix with RAVE, 39 
mute or unmute all, 163 
set levels, 43 
set to follow video, 51 
signal flow, 42 
terms and concepts to know, 41 

browser 
clips, 23 

chroma key, 139 
add mask, 149 

clear solo, 169 
clip 

media wipe transition, 131 
Clip Browser, 23 
Clip Edit window, 25 
Clip Store 

set path, 22 
clips 

workflows, 21 
Code of Ethics, 2 
Command Control 

Take Graphic and Cut Key, 79 
Control Commands 

XPression, 69 
Control Panel(physical) 

comparison to DashBoard Panel, 93 
Crash Record 

from XPression, 29 

cusomize auxilliary audio output, 55 
Custom Control 

add pause, 117 
audio, clear solo, 169 
chroma key, 150 
clear pre-fade listen, 167 
command to assign a key source, 117 
command to call up a graphic, 123 
command to transition video, 125 
cut key on command, 120 
double-box, 91 
mute or unmute all, 163 
naming, 90 
play from ShotBox, 90 
set an audio fader level, 155 
Show Open, 173 

Custom Controls 
about, 62 
audio, 155 
play from ShotBox, 111 

DahBoard Panel 
comparison to physical panel, 93 

DashBoard 
audio mix, 39 

double box, 91 
edit 

Clip Store settings, 22 
encode video, 32 
Ethics 

Ross Code of Ethics, 2 
export 

animated graphic as clip or images, 131 
fader level 

audio, 155 
graphic 

call up in a Custom Control, 123 
graphics 

access XPression, 11 
add text, 12 
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load, 12 
green screen, 139 
load graphics, 12 
mask 

add to chroma key, 149 
media 

locate number, 133 
Media Manager 

locate media number, 133 
media wipe, 131 
memories 

about, 66 
memory 

save and effect, 103 
modify graphics, 12 
monitor 

clip server channels, 26 
monitor audio 

customize, 52 
mute or unmute all 

Custom Control, 163 
name 

Custom Control, 90 
number, for media 

locate in Media Manager, 133 
pause 

add to a Custom Control, 117 
physical Control Panel 

comparison to DashBoard Panel, 93 
play 

Custom Controls from ShotBox, 111 
pre-fade listen 

Custom Control, 167 
RAVE 

audio set to follow video, 51 
audio signal flow, 42 
configure the GUI, 43 
customize audio monitoring, 52 
customize auxilliary audio output, 55 
set levels, 43 

RAVE Audio Mixer, 39 
Record Client window, 29 
Ross 

Code of Ethics, 2 
save 

effect as memory, 103 

switcher settings to a memory, 66 
sequence 

show open, 173 
Server Channel window, 26 
set 

audio fader level, 155 
ShotBox 

access and play Custom Controls, 111 
shotbox commands 

about, 62 
for XPression, 69 

Show Open sequence, 173 
solo, clear, 169 
text 

add or modify in graphics, 12 
transition video 

in a Custom Control, 125 
two box, 91 
video 

transition in a Custom Control, 125 
Video Coder 

XPression, 32 
wipe 

XPression graphic, 113 
workflow 

clips, 21 
XPression 

access graphics, 11 
assign as key source in Custom Control, 

117 
call up graphic in a Custom Control, 123 
Clip Browser, 23 
Clip Edit window, 25 
Clip Store, 22 
Control Commands for, 69 
Custom Control 

Take Graphic and, 79 
Take Graphic and Cut Key.  

export animated graphic as clip or 
images, 131 

graphic for a double-box, 91 
record clips, 29 
Server Channel window, 26 
shotbox command setup, 69 
Video Coder, 32 
wipe, 113 

 

 

 


